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Introduction

Your EPSON Stylus® COLOR 740 printer is the ideal output device
for business graphics, layout proofs, digital photography, or any
project you create on your computer. With resolutions up to 1440 by
720 dpi and EPSON'’s unique variable micro droplet technology,
you get amazingly realistic photographic images, vivid color
graphics, and razor-sharp black text.

The printer software for Microsoft® Windows® and Macintosh®
provides advanced color management with adjustable levels of
brightness, contrast, sharpness, and other settings. Support for
ColorSync™ 2.01 and two Windows color matching methods gives
you even more precise color control.

EPSON's specially formulated ink cartridges and wide variety of ink
jet papers offer the most flexibility for getting the results you want.
With standard parallel, serial, and high-speed USB (Universal
Serial Bus) ports, setting up your printer is fast and easy.

This chapter gives you general information about your printer in
these sections:

»  Windows System Requirements

» Macintosh System Requirements

» Printer Parts
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Introduction

» How To Use Your Manuals

» ENERGY STAR Compliance
» Year 2000 Ready

» Important Safety Instructions

Windows System Requirements

To use your printer and its software with a PC, your system should
have:

» An IBM® compatible PC with at least a 386/25 MHz (for
Windows 3.1x), 486/25 MHz (for Windows 95 or Windows
NT® 4.0), or 486/66 MHz (for Windows 98) processor

» DOS, Microsoft Windows 3.1x, Windows 95, Windows 98, or
Windows NT 4.0

» Atleast 16MB of RAM (32MB for Windows 3.1, 95, or 98 or
64MB for Windows NT 4.0 recommended)

» At least 50MB of free hard disk space for storing images
(100MB recommended)

» VGA, Super VGA, or better display adapter and monitor

» Double-speed CD-ROM drive (quad-speed or faster
recommended) for installing the printer software
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» A shielded, twisted-pair parallel cable (6 to 10 feet long) to
connect your computer to the printer’s parallel connector. The
cable must have a D-SUB, 25-pin, male connector for your
computer and a 36-pin, Centronics® compatible connector for

Caution: the printer.

Using an improperly If your computer has a USB port with Windows 98 pre-installed,
shielded USB cable— you'll need a shielded USB interface cable, from Series A
especially a cable (computer) to Series B (printer) up to 5.9 ft. (1.8 meters) long.
more than 5.9 ft. (1.8 EPSON recommends the use of an EPSON USB cable or other

meters) long—may .
cause the printer to properly shielded cable.

malfunction.

Macintosh System Requirements

To use your printer and its software with a Macintosh, your system
should have:

» One of the following Macintosh models:

LC475, LC575, LC630

Quadra series

Centris series

PowerBook® series (190, 520, 540, 550 or later)
PowerBook Duo 280, 2300c/100

Performa® 475, 575, 588, 630, 5210 or later
Power Macintosh series
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» System 7.1 or later (7.6 or later recommended); some
application software on the EPSON CD-ROM may require
System 7.52 or later

» Atleast 16MB of RAM (20MB or more recommended)

» At least 50MB of free hard disk space for storing images
(100MB recommended)

» 13-inch RGB display or better

» Double-speed CD-ROM drive (quad-speed or faster
recommended) for installing the printer software

» Standard Apple® System Peripheral-8 cable or equivalent
(RS-423, 8-pin mini DIN male/male, Belkin F2V024
recommended)
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Printer Parts

paper support

edge _
guides printer cover
output tray
sheet feeder output tray extensions

paper thickness

ink cartridge holders control panel



Introduction

How To Use Your Manuals

To set up your printer and install the printer software, see the Start
Here card. This manual contains the following information:

Basic Printing covers the basics of printing with Windows or
Macintosh.

Advanced Printing tells you how to print using custom settings for
print quality, color management, and distinctive layouts.

Printing on Special Media gives guidelines for selecting the right
paper or other media for your print job and instructions for loading it
in your printer.

Managing Print Jobs explains how to control print jobs and check
printer status while you’re printing.

Maintenance and Transportation gives instructions for replacing ink
cartridges, cleaning and aligning the print head, and cleaning and
transporting the printer.

Troubleshooting provides solutions for any problems you may have
with your printer or software.

Specifications provides the technical details on your printer, ink
cartridges, and EPSON papers.

To go right to the section you need, see the Index.
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Warnings, Cautions, Notes, and Tips

You'll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Notes contain important information about your printer.

Cautions must be observed to avoid damage to your equipment.
-

TEF Tips contain additional hints for great printing.

ENERGY STAR Compliance
Grerite

As an ENERGY STAR Partner, EPSON has determined that this
product meets the ENERGY STAR guidelines for energy efficiency.

The EPA ENERGY STAR Office Equipment program is a voluntary
partnership with the computer and office equipment industry to
promote the introduction of energy-efficient personal computers,
monitors, printers, fax machines, and copiers in an effort to reduce
air pollution caused by power generation.
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Caution:

Always turn the
printer off using the
O power button.
Don't switch off the
electrical outlet or
power strip, or unplug
the printer until the
O power light is off.

Introduction

Year 2000 Ready

Your EPSON printer is Year 2000 Ready. However, be sure
the other parts of your computer system are also ready for the
year 2000.

Important Safety Instructions

Before using your printer, read the following safety instructions to
make sure you use the printer safely and effectively:

» Turn off and unplug the printer before cleaning. Clean with a
damp cloth only. Do not spill liquid on the printer.

» Do not place the printer on an unstable surface or near a
radiator or heating vent.

» Do not block or cover the openings in the printer’s cabinet or
insert objects through the slots.

» Use only the type of power source indicated on the printer’s
label.

» Connect all equipment to properly grounded power outlets.
Avoid using outlets on the same circuit as photocopiers or air
control systems that regularly switch on and off.

Page 16



Introduction

Place the printer near a wall outlet where the plug can be easily
unplugged.

Placez I'imprimante pres d’une prise de contacte ou la fiche
peut étre débranchée facilement.

Do not let the power cord become damaged or frayed.

If you use an extension cord with the printer, make sure the
total ampere rating of the devices plugged into the extension
cord does not exceed the cord’s ampere rating. Also, make
sure the total ampere rating of all devices plugged into the wall
outlet does not exceed the wall outlet's ampere rating.

Except as specifically explained in this manual, do not attempt
to service the printer yourself.

Unplug the printer and refer servicing to qualified service
personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered the
printer; if the printer has been dropped or the cabinet damaged;
if the printer does not operate normally or exhibits a distinct
change in performance. Adjust only those controls that are
covered by the operating instructions.

Do not put your hand inside the printer or touch the cartridge
during printing.

Under normal circumstances, ink will not come out of the
cartridge. If it does get on your skin, wash it off with soap and
water. If it gets in your eyes, flush them immediately with water.
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Introduction

Keep ink cartridges out of the reach of children.

Do not dismantle the ink cartridges or try to refill them. This
could result in damage to the print head.

Once you install an ink cartridge, do not open the clamp or
remove the cartridge except to replace it with a new one. The
cartridge may become unusable otherwise.

Install the ink cartridge immediately after you remove it from its
foil package. Leaving the cartridge unpacked for a long time
before use may result in reduced print quality.

Do not use an ink cartridge beyond the date printed on the
cartridge package. For best results, use up the ink cartridges
within six months of installing them.

Do not shake an ink cartridge; this can cause leakage.

Always turn the printer off using the & power button. When you
press this button, the O power light flashes briefly then goes
out. Do not unplug the printer or turn off the power to the outlet
until the O power light is off.

Before transporting the printer, make sure the print head is
capped in the far right position and the ink cartridges are in
place.
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Note:

For instructions on
printing with DOS,
see DOS Support.

Basic Printing

It's easy to print all your color and monochrome documents with
your EPSON Stylus COLOR 740. First set up your printer and
install the software, following the instructions in the Start Here card.
Read this chapter to find out about:

» Printing from Windows

» Printing from a Macintosh

Printing from Windows

This section tells you about:
» Setting Printer Options from Windows Applications

» Setting Default Printer Options
» Checking Printer Status
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Note:

You can also set
printer options by
clicking Print Setup in
the File menu, then
clicking the Printer,
Setup, Properties, or
Options button.
However, in most
applications you'll
then have to select
the Print option from
the File menu to print
using your changes.

Basic Printing

Setting Printer Options from Windows Applications

This section describes the settings you'll need to check for all your
everyday printouts. See Advanced Printing for information about
advanced settings for special print jobs.

1 Open a Windows application and select a file you want to print.

2 Open the File menu and click Print. You see the Print dialog
box for your application.

Print

— Prirkter
Mame:
Status:
Type:
‘where:
Comment:

[ 7] x]
1
EPSOMN Styluz COLOR 740 Properties I
Default printer; Ready
EPSON Styluz COLOR 740
LPT1:
[~ Print ta file

r— Print range

Copie:

Fal Mumber of copies: m

 Pages  from: [1 !D:I_

) Belection ™ Callate
Canicel |

Click Properties

3 Make sure your EPSON Stylus COLOR 740 printer is selected,
and then click the Properties , Printer , Setup, or Options
button. (You may have to click a sequence of buttons in
different dialog boxes.)
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L
Tip

-l
To print at the highest
resolution (1440 dpi),
you need to use plain
paper, Photo Paper,
or one of the Photo
Quality media. For the
best printing at any
resolution, always use
EPSON media.

Basic Printing

You then see the printer settings dialog box:

EPSON Stylus COLOR 740 Properties [ 7] ]
CIICk tO Select Main IF’aper | Layﬂull Litiity I
d K t Media Type Ink.
our media type —  EEEE | | [5 © o
Y yP © Bk Use the
. ~Mod .
CIICk to SeIeCt ' Automatic Cluality -—j peed Qualltylspeed
Automatic mode o mET— slider to select
Advanced.. yo u r p rl nt
resolution
Current Settings
ﬁ Letter \"\’ Marmal - 360dpi
(% Pomait @ Microweave : DIf
r} Mane 2 High Speed : On
@ Mo W atermark. 6 Color Adjustment

Click for more
o ] cee || Wl information

Click the Main tab if necessary. Then choose the Media Type

you want to print on from the following list:

Plain paper

360 dpi Ink Jet Paper
Photo Quality Ink Jet Paper
Photo Paper

Photo Quality Glossy Film
Ink Jet Transparencies
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Note:

The Quality/Speed
slider is not available
for certain media

types.

Basic Printing

10

11

The type of paper you choose determines the print quality
(resolution) you can use. It's very important to select the correct
setting for your paper. If you're not sure which to choose, see
Selecting Special Media.

Choose Color or Black ink.

Now make sure the Mode option is set to Automatic . This is
the easiest way to get good printing results for all kinds of
documents, on all types of paper.

Set the slider to Quality or Speed. This lets you choose
between the fastest printing or the highest resolution for the
media you’re using.

To select 1440 dpi on plain paper or any other available
resolution for your media, you need to access the Advanced
dialog box; see Customizing Print Quality and Special Effects
for instructions.

Click the Paper tab and choose your paper size, number of
copies, orientation, and printable area settings. See Selecting
Paper Options in Windows for instructions.

Click the Layout tab (not available with Windows 3.1) and
check the reduce/enlarge, page layout, and watermark
settings. See Choosing Print Layout Options in Windows for
details.

Click OK when you're finished checking your settings. The
dialog box closes. Click OK until you see the Print dialog box.

In the Print dialog box, click OK or Print .
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While your document is printing, a window appears showing
the printer status and the progress of your print job. See
Checking Printer Status for more information.

Setting Default Printer Options

When you change printer settings through your software
application, the settings apply only to the application you’re using.
To adjust the default settings for all your Windows applications,
access the printer settings through the Printers utility or Control
Panel (Windows 3.1). Close all your applications before you start. If
you don’t, you may have to close and reopen them to use the new
default settings.

J Setting Default Options in Windows 95, Windows 98, or

Note: -
You can access the Windows NT

default Windows NT 1 Click Start, point to Settings , and select Printers .

printer software ) . .
settings only if you 2 Right-click the EPSON Stylus COLOR 740 icon.

have the appropriate 3 Select Properties or Document Defaults (Windows NT), then

network access click the Main tab. You see the printer settings dialog box
privileges, such as shown under Setting Printer Options from Windows
Administrator. Applications with some additional tabs at the top.
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Setting Default Options in Windows 3.1
1 Double-click the Control Panel icon in the Main group.

2 Double-click the Printers icon.

3 Select EPSON Stylus COLOR 740 from the list of printers and
click Setup . You see the printer settings dialog box shown

under Setting Printer Options from Windows Applications.

Checking Printer Status

While your document is printing, your printer software reports how
the job is doing. See the following for your operating system:

»  Windows 95, Windows 98, or Windows NT 4.0
»  Windows 3.1
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Windows 95, Windows 98, or Windows NT 4.0

After you send a print job in Windows 95, 98, or NT, the Progress
Meter window appears on your screen:

Click to cancel

EPSON Stylus COLOR 740-LPT1: .
& Sl Click to pause

ot CIET] I

This .“"‘-éi’j Prograrns. tat [0413)  Remaining 2min —— Click to restart

information

appears onIy Statuz Manitar . .

if you installed — Elack Irk: | Paperduto Sheet Feeder Detaid CIICk. to VIeW. the Status

Status Coorlnk: T [ M_onltor 2 Printer Status
. window

Monitor 2

The Progress Meter shows the progress of your print job and the
status of your printer. You can use the buttons to cancel, pause, or
restart your print job.

If you installed Status Monitor 2, you also see information about
how much ink you have left and can view the Status Monitor 2
Printer Status window. See Using Status Monitor 2 for more
information.

You can also set up the way your printer software sends print jobs
and select whether to display the Progress Meter dialog box or not;
see Selecting the Speed & Progress Options for instructions.
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Basic Printing

Windows 3.1

After you send your print job, the EPSON Despooler dialog box

appears on your screen:

Click to pause
or resume

Yrite - README.WRI

printing

Click to cancel —
printing

Page: 1 of 27
Copy: 1 of 1

EPSON Stylus COLDR
LPT1:

— = |

|| PP
44

About.._

Help

Click to restart

printing

This dialog box shows the progress of your print job and the status
of your printer. If you run out of paper while printing, for example,
the Despooler warns you. You can use the buttons to cancel,
pause, or restart your print job.

You can also control print jobs using the Spool Manager; see Using
the Spool Manager for more information.
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Note:

On the Macintosh,
printer settings are
saved with your
document, but not
from one application
to another. If you
want to reuse
settings, you can
create document
templates for your
favorite applications.

You can also create
custom setting groups
in your printer
software that you can
select each time you
open an application.
See Saving Custom
Settings for details.

Basic Printing

Printing from a Macintosh

When you print with a Macintosh, you need to check the printer
software settings in each application you use. This section
describes the settings you'll need to check for all your everyday
printouts. See Advanced Printing for information about advanced
settings for special print jobs.

Follow these steps to print from a Macintosh:

1 Open a Macintosh application and select a file you want to
print.

2 Open the File menu and click Page Setup (Document Setup
in some applications). You see the Page Setup dialog box:

Paper Size: [Letter [+] [ cancel ]

:
Orientation: . Portrait Landscape _

[ Rotate by 180 degrees

Reduce or Enlarge: %

Printable Area: @ Standard O Maximum
[ Centered

3 Choose your paper size, orientation, and other options as
described in Selecting Paper Options on a Macintosh and
click OK.
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Click to
select your
media type

Click to
select
Automatic

mode

Tig

For printing at the
highest resolution
(1440 dpi), you need
to use plain paper,
Photo Paper or one of
the Photo Quality
media. For the best
printing at any
resolution, always use
EPSON media.

Basic Printing

4  Now open the File menu and click Print. You see the main
printer settings dialog box:

EPSON

SC 740 5.50E

Copies: El

Pages: ® All

ol I~ ]

Cancel

o CUFFENESELHNGS g

Ink i rr—xs
i Letter
Media Type: | Plain Paper [+) @ 8;‘:;‘::’( (3 Portrait

— Mode

| [ NoWatermark

Automatic
Custom

Quality  @==m]) Speed

i (% PrintLayout: None
# Normal - 360 dpi

MicroWeave : Off
| 2 High Speed :0n

B

Advanced... ] [ Custom Settings

[~] i @ Color Adjustment

Use the Quality/Speed slider to select your print resolution

5 Choose the number of copies and indicate which pages you
want to print.

6 Choose the Media Type you want to print on from the following

list:

» Plain Paper
» 360 dpi Ink Jet Paper
» Photo Quality Ink Jet Paper
» Photo Paper

» Photo Quality Glossy Film

» Ink Jet Transparencies
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Note:

The Quality/Speed
slider is not available
for certain media

types.

Basic Printing

10

11

The type of paper you choose determines the print quality
(resolution) you can use. It's very important to select the correct
setting for your paper. If you're not sure which to choose, see
Selecting Special Media.

Choose Color or Black ink.

Make sure the Mode option is set to Automatic . This is the
easiest way to get good printing results for all kinds of
documents, on all types of paper.

Set the slider to Quality or Speed. This lets you choose
between the fastest printing or the highest resolution for the
media you're using. To select 1440 dpi on plain paper or any
other available resolution for your media, you need to access
the Advanced dialog box; see Customizing Print Quality and
Special Effects for instructions.

Click the |2 Layout icon and check the fit to page, watermark,
page layout, and print order settings. See Choosing Print
Layout Options on a Macintosh and Selecting Print Order
Options for details. Then click OK to return to the printer
settings dialog box.

To select background printing options for your print job before
you print, click the Background Printing icon. See Setting
Up Background Printing Options for details.
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Note:

You can also turn
background printing
on or off in the

Macintosh Chooser.

Basic Printing

12 If you want to preview your printout to view how the current
layout, watermark, print order, and orientation settings look,
click the |@) Preview icon, then click the Preview button. See
Using Print Preview on the Macintosh for details.

13 Click Print when you're finished checking your settings.

If you chose background printing when you set up your printer,
you can continue working while your document is printing. See
Using Monitor3 for details.

Setting Up Background Printing Options
Before you print your document, you can set up the following
background printing options:
» Turn background printing on or off
» Set a priority for the print job in the print queue
Set a specific time for printing the print job
» Hold the print job for later printing
Follow these steps:

1 Open an application and select a document you want to print.

2 Open the File menu and click Print. You see the printer
settings dialog box.

3 Click the Background Printing icon.
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You see the following dialog box:

epson
Background Printing:

@& On ) Off

Not available if Print Time:

background O Urgent

printingis  — | @ Normal

turned off OpPrintat: | 5/ 1/98| 5 | 1:07 AM|
3 Hold

4  To turn background printing on or off, click the On or Off radio
button.

5 To select a priority for your print job in the queue of jobs waiting
to print, click one of the following:

» Normal to print in the order the job is received
» Urgent to print before any Normal priority job

» Printat: to print at the specific time you enter in the day and
time in the fields to the right

» Hold to hold the print job in the print queue until you're
ready to release it using EPSON Monitor 3; see Using
Monitor3 for details.

6 Click OK to save your settings and return to the printer settings
dialog box. (Click Cancel if you want to cancel your settings
and return.)
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Advanced Printing

When your presentation graphics, photographs, or other projects
have special printing requirements, you can use the advanced
settings in your EPSON Stylus COLOR 740 software. You can
choose custom project types or adjust individual settings like
brightness, contrast, sharpness, and halftoning. For
professional-quality color accuracy, you can use a color matching
mode.

Your printer software’s print layout options let you print almost any
size image on your printer, proof multiple pages on one sheet of
paper, and add watermarks (not available with Windows 3.1).

This chapter includes the following information:

» Using Custom Project Types

» Customizing Print Quality and Special Effects
» Customizing Color Settings

» Using ColorSync on the Macintosh

» Selecting Paper Size and Orientation Options
» Selecting Print Layout Options

» Using Print Preview on the Macintosh

» Saving Custom Settings
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Click Custom , then click here
to see a list of project types

Using Custom Project Types

Custom project types provide an easy way to fine-tune your printer
settings for a specific type of project. Follow these steps to print

with custom project types:
1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh. You see one of the

following dialog boxes:

EPSON Stylus COLOR 740 Properties HE

Main | Paper | Layout| Utiity |

Media Type

IF‘Ialn paper

Ik
j ’V & Colar

" Black

i~ Mod;

" Automatic
& Custom

Custom Settings k|
Advanced.

Current Setings

Click Advanced , then click here
to see a list of project types

[ Main || Poper | uiy |

HMode
A " o Automatic

 44® Advonoes
Il:ustum Settings |_t| Save Settings. . I

Media Type IPIain paper

Current Settings

|£I ' @ Color
< Black

[ Letter &£ Normal - 360dpi
(% Portait O Micrdweave : Off
(G None =% HighSpeed: On
B Wowatemark &) Color Adustment
0K | Concel | Hep |

Windows 95, 98, NT

Advanced Printing

ﬁ Letter (f MicioWeave : Off
@ Portrait i High Speed : On
% Normal - 360 dpi &) Color Adjustment
| EPSON |
| 0K I | Cancel I ‘ Hupspsta I ‘ Help I
Windows 3.1
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Cnpies:lil Pages: @ All O l:l ~ l:l
. - CUFrent Settings s
n i
: - rf; Letter
. Media Type: & e | 4 portrait
Click Custom , then — @ No Watermark
. . [ Printlayout: None
click here to see a list 5] O Automatic é:lm“.f -3 i
. p icroweave :
of project types S & Custom _ 2 igh Speed - on
[_Advanced... | [ Custom Settings [+] & Color Adjustment

Note:

Always choose your
Media Type and Ink
setting before you
select a custom
project type. Some
project types may not
be available with the
Media Type or Ink
settings you choose.

Printing with
PhotoEnhance3 or
PhotoEnhance may
take longer on some
systems and images.

Advanced Printing

EPSON SC 740 5 50E @ -

Macintosh

Choose the Media Type you want to print on. (If you're not sure
which setting to choose, see Selecting Special Media.)

Choose Color or Black ink.

Click Custom (in Windows 3.1, click Advanced ), and then click
Custom Settings . You see the list of project types.

Choose the right setting for your project and Media Type
following these guidelines:

» PhotoEnhance3 (Windows 95, 98, NT, or Macintosh) or
PhotoEnhance™ (Windows 3.1)
For printing images captured using a video camera, digital
camera, or scanner. Produces sharper images and more
vivid colors by automatically adjusting the contrast,
saturation, and brightness. Corrects for overall under- and
over-exposure of the original image.
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Digital Camera (not available with Windows 3.1)
For printing images captured using a scanner or digital
camera. Corrects noise and other common flaws.

Text/Graph

For printing graphics-intensive documents like presentation
pages with charts and graphs. Intensifies colors and
lightens the midtones and highlights.

Economy
For rough drafts of text only. Saves ink.

ICM (Windows 95 and Windows 98 only)

For printing documents created in an ICM compatible
application. If you're using an ICM compatible monitor,
adjusts printed colors to closely match the screen colors.

sRGB (Standard Red Green Blue; not available with
Windows 3.1; recommended only with Windows 98)

For printing documents created in an SRGB compatible
application using sRGB colors, such as those designed for
the World Wide Web. First set up your SRGB compatible
devices (such as your monitor and printer) to use an sRGB
color profile; see your Windows 98 online help for details.

ColorSync (Macintosh only)

Automatically adjusts printout colors to closely match the
colors on your screen. For more information, see Using
ColorSync on the Macintosh.
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After you customize
your print settings for
a special project, you
can save them as a
group. Then you can
reuse them whenever
you print a similar
project. See Saving
Custom Settings for
instructions.

Advanced Printing

v

In Windows, click the Paper and Layout tabs (not available on
Windows 3.1) to check or change any necessary settings, as
described in Selecting Paper Options in Windows and
Choosing Print Layout Options in Windows.

On a Macintosh, check or change any necessary settings on
the Page Setup and the Layout dialog boxes as described in
Selecting Paper Options on a Macintosh and Choosing Print
Layout Options on a Macintosh.

When you're finished, click OK (Windows) or Print (Macintosh).
If you're using Windows, click any other buttons that your
application uses for printing.

Customizing Print Quality and Special
Effects

If you need the maximum control over your project, or you want to
experiment with special effects, you can adjust the custom settings
in your printer software. Follow these steps:

1
2

Create your image or document in your application software.

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

Click Custom, and then click the Advanced button. (In
Windows 3.1, click Advanced , then click the More Settings
button.)
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You see the Advanced dialog box (called More Settings in
Windows 3.1):

¥ Media Type @ Color Managsment

e : Click here to

@ Color Adjustment

Ink. .
" & Calor ‘ :::Ch:nnsnhamea Change your Pnnt
2 plagk I . .
i ey [ Quality (resolution)

s Mods Automatic ~

Fine Dithering 5| Bighness [0
Contrast 0 ———,

Saturation IT ——
- +

Some of these
options are

@& Microweave

. =7 High Soesd O fyan  [+0 ——.
automatically set o o o [ 05 | g
or disabled by B Einest Det] o vl [0 T
other settings e sweswmgs. | 06| e | e |
ou choose .
y Windows 95, 98, NT
| MoreSettings.. | .
£ s (TR ® O Click here to
@ Color Adjustment )
& Moo ype [Fimpoper———&] | Mode change your Print
" e G || e OTECLC T uality (resolution
M Coneast [0 F T T Q y ( )
B¢ Halftoning Saition E’“_El:D:EJ
Frotwam g | O W B LT
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or disabled by i Fest ot —_—
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you choose Windows 3.1
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Note:

The available Print
Quality settings may
be limited by the
Media Type you
choose.

Advanced Printing

Click here to change
your Print Quality
(resolution)

Some of these
options are
automatically set
or disabled by
other settings
you choose

=# MediaType: Plain Paper [~]
rInk —M——
FE3 @ Color

ﬂ () Black

g Print Quality: [ Normal- 360dpi [ %]

B Halftoning:
Fine Dithering  [+~]

o [ Microweave

= [x] High Speed
% [ Flip Horizontal

@ Color M
® Color Adjustment
() PhotoEnhance3
() ColorSync

vode:  [Autamatic 7]

Brightness EI (m
Contrast E (%
Saturation El | |—
o tyan 0 ] ==
® Magenta El @U@
o Yellow L

i [ Finest Detail

[(save settings.. | [ Help | [ cancel | [ 0K |

Macintosh

Choose the Media Type and Ink settings you want to use,
following the guidelines in Printing from Windows and Printing

from a Macintosh.

Choose one of the following Print Quality options:

» Economy

For low-resolution rough drafts on plain paper. Saves ink.

» Normal - 360 dpi

For most documents on plain paper, transparencies, or 360

dpi Ink Jet Paper.
» Fine - 720 dpi

For high-resolution output on plain paper, Photo Paper, or
Photo Quality Ink Jet Paper.
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Note:

In Automatic mode,
the Halftoning setting
is selected based on
the data in your print
job. In Custom mode,
Halftoning is
preselected for each
project type setting.

Some of the print
options at the bottom
left of the Advanced
dialog box are
automatically
selected or disabled
by the Print Quality
(resolution) you
choose.

Advanced Printing

Photo - 720 dpi
Excellent high-resolution output on plain paper, Photo
Paper, or Photo Quality Ink Jet Paper.

Photo - 1440 dpi
For the highest-resolution output on plain paper, Photo
Paper, or Photo Quality media.

6 Choose one of the following Halftoning options:

No Halftoning
For printing black text only.

Error Diffusion
For printing photographic images. Blends each color dot
with the dots around it.

Fine Dithering
For printing graphs or other images that require precise,
solid areas of bright colors.

7 Choose any of the following print options:

MicroWeave

For improved print quality. Prints graphic data in finer
increments to eliminate unwanted banding effects (light
horizontal lines). Always use for color printing.

High Speed

For fast, bidirectional printing at lower quality. If vertical
lines in your printout are misaligned when you use the High
Speed setting, you may need to turn it off or align the print
head; see Aligning the Print Head for instructions.
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Note:

The appearance of
the Color section of
the More Settings
dialog box always
appears as shown in

Using Custom Color

Management Modes

on Windows 3.1.

Advanced Printing

» Flip Horizontal
Prints a mirror image of your document. Use with iron-on
transfer paper so your ironed-on printout will read correctly.

» Finest Detalil
For printing text, graphics, and line art with very sharp
edges. Slows print speed and increases your system
memory requirements.

8 Click OK if you're ready to return to the printer settings dialog
box, or see Customizing Color Settings if you want to adjust
your document’s color settings.

Customizing Color Settings

There are three ways to manage the color in your documents using
your printer software:

» Using PhotoEnhance3 or Digital Camera Correction Mode to
automatically correct digital photographs for exposure and
other common flaws, and to adjust the tone or sharpness.

» Using Custom Color Management Modes to select individual
color values to fine-tune the color in text, graphics, or economy
mode documents.

» Using a Color Correction System for maximum color accuracy.

The appearance of the Color Management section of the Advanced
dialog box changes, depending on the settings you've selected.
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Note:

The Color
Management section
also changes to this
view if you select the
PhotoEnhance3radio
button on the
Advanced dialog box.

Using PhotoEnhance3 or Digital Camera Correction
Mode

To correct the exposure, tone, and sharpness of digital images, you
can use PhotoEnhance3 (PhotoEnhance on Windows 3.1) and/or
Digital Camera Correction mode (not available with Windows 3.1).

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

3 Click Custom, then select either PhotoEnhance3 or Digital
Camera as described in Using Custom Project Types.

4  Click the Advanced button. The Color Management section of
the Advanced dialog box appears as shown here:

[ Sharpness

—GCDIDr Manag t —a Calar Management
(3 Color Adjustment " Color Adjustment
82:::::“":"“3 Click to select a Tone @ PhotoErhanced

setting, if necessary. L
Tone Changes are shown =
® Normal in the example i
{3 Hard p & Nomal
O sepia photograph.  Had
' Sepia

[ Digital Camera Correction

Click to turn on
Digital Camera
Correction mode

[ Digital Camera Corection

and/or sharpen

Macintosh

Advanced Printing

I~ Sharpness

the image.

Windows 95, 98, NT
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5 You can customize your image using these settings:

» Select a Tone setting for your image: Normal for standard
tones, Hard for high contrast, or Sepia for an old-fashioned
photo look.

» Turn on Digital Camera Correction to correct noise and
other flaws common to digital camera images.

» Select Sharpness to sharpen the image, especially the
edges.

6 Click OK to return to the printer settings dialog box.

Using Custom Color Management Modes

You can choose from several custom Color Management modes or
manually adjust brightness, contrast, saturation, and CMY (cyan,
magenta, yellow) color values.

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

3 Click Custom (in Windows 3.1, click Advanced ), then select
either Text/Graph or Economy as described in Using Custom
Project Types.
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Note:

The Color
Management section
also changes to this
view if you did not
select a Custom
project type or if you
select the Color
Adjustment radio
button on the

Advanced dialog box.

Advanced Printing

4  Click the Advanced button. The Color Management section of
the Advanced dialog box appears as shown here:

Not available
with
Windows 3.1;
ICM not
available with
Windows NT

— @& Color Management

@ Color Adjustment
" PhatoE nhance3
0 ICH
¢ sAGB

Mads [aomatic ]
Contrizst  [+0 | —_—
Saturation |T _ —J— X
O fn [0 ——p—
® Magenta [+0 | —_—
O Yelow [0 ——F——

r &b Color Manag t
#® Color Adjustment
{2} PhotoEnhance3
{2 ColorSync

Mode:  (Automatic ]

Brightness

Contrast
Saturation
@ Cyan

@ Magenta
< Yellow

CIETTETETE

Windows

Macintosh

5 Choose one of the following Color Adjustment Modes

» Automatic
Analyzes the color information in your project and optimizes
color correction accordingly.

» Photo-realistic

For printing color photographs.

» Vivid

For printing graphics-intensive documents like presentation
pages with charts and graphs. Intensifies colors and
lightens the midtones and highlights.
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» No Color Adjustment
Disables the color adjustment features of the printer
software so you can use a stand-alone color management
utility.
If you want to specify individual color correction values, use the
sliders to increase (drag right) or decrease (drag left) the
settings listed below.

» Brightness
Makes your image lighter or darker.

» Contrast
Increases or decreases the difference between the bright or

dark parts of an image.

» Saturation
Makes colors more vivid or less vivid.

» Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink colors
that combine to make a full-color picture. Use these sliders
to fine-tune the color balance in your printout.

Click OK to return to the printer settings dialog box.
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Using a Color Correction System

To achieve the maximum color accuracy, you can use Image Color
Matching (ICM; Windows 95 and 98 only), Standard Red Green
Blue (SRGB; Windows 95, 98, and NT only), or ColorSync

Note: ; ; ;
Macintosh only), if your system is set up to use them.
The Color ( y)ity y P
Management section 1 Create your image or document in your application software.
a_Iso (_:hanges to this 2 Access the printer settings dialog box as described in Printing
view if you select the from Window. Printing from a Macintosh
ICM. SRGB. or 0 owWsS or g from a Macintosh.
ColorSync radio 3 Click Custom, then select either ICM (Windows 95 or 98 only),
button on the sRGB (Windows 95, 98, and NT only), or ColorSync
Advanced dialog box. (Macintosh only) as described in Using Custom Project Types.
4  Click the Advanced button. The Color Management section of
the Advanced dialog box appears as shown here:
_&l Cid epramsiti 7%52::::1justment
 Color Adjustment gz::];:s?nl::antea
Not available | £ FhoteEnhances = For details, see
W|th —fs lEM Proﬂle:- —EPSONStandard —Uslnq COIOI’SVnC
Windows NT | & 58 Renderina nter [ Perceptual 7] on the Macintosh
Windows 95, 98, NT Macintosh

Advanced Printing
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5 Select one of these color correction systems:

ICM (Windows 95 and Windows 98 only)

For printing documents created in an ICM compatible
application. If you're using an ICM compatible monitor,
adjusts printed colors to closely match the screen colors.

sRGB (Standard Red Green Blue; not available with
Windows 3.1; recommended only with Windows 98)

For printing documents created in an SRGB compatible
application using sRGB colors, such as those designed for
the World Wide Web. First set up your sSRGB compatible
devices (such as your monitor and printer) to use an sRGB
color profile; see your Windows 98 online help for detalils.

ColorSync (Macintosh only)

Automatically adjusts printout colors to match colors on the
screen. See Using ColorSync on the Macintosh for more
information.

6 Click OK to return to the printer settings dialog box.

Using ColorSync on the Macintosh

Every device you use for producing or viewing colors—your
monitor, scanner, and printer—employs a different color
technology. The Macintosh ColorSync system helps you control all
your devices so their colors match your printer’s as closely as
possible.
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ColorSync uses profile information from each device—including
your EPSON Stylus COLOR 740 printer—to achieve accurate color
matching. First you have to make sure your monitor’s profile is set.
Then you can use your printer software to specify the exact method
of color matching you want to use.

Follow these steps to set your monitor’'s ColorSync profile and use
your printer software’s ColorSync features:

1

~N o o~ WD

(o0}

Open the ColorSync System Profile under Control Panels
on the Apple menu.

Click the Set Profile button.

Select your monitor from the list, and then click Select.
Close ColorSync System Profile.

Open an application and select a document to print.
Open the File menu and click Print .

Click Custom , then click Advanced . You see the Advanced
dialog box.

Click the ColorSync radio button.

For Profile , choose EPSON Standard . This is the ColorSync
profile created especially for your printer. Don’t choose any
other printer profile you may have on your system.
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10 Choose one of the following options for Rendering Intent :
» Perceptual

_..! For printing scanned photographs.

» Saturation
Note: _ For printing graphics-intensive documents like presentation
The Rendering Intent pages with charts and graphs.
options may be ] _
limited by the Media »  Colorimetric _
Type you've selected. For matching colors on your screen as exactly as possible.

Reproduces colors the way your eye distinguishes them.
11 Click OK to return to the printer settings dialog box.

Selecting Paper Size and Orientation
Options

Your printer can print on paper up to 9.5 inches wide and up to

44 inches long in either portrait or landscape orientation. If you print
multi-page documents or multiple copies of documents, you can
print the pages collated and in reverse order. You can even rotate
the printed document by 180 degrees to make it closer to the
bottom of the paper (not available with Windows 3.1).

Follow the steps in the section for your operating system:

» Selecting Paper Options in Windows

» Selecting Paper Options on a Macintosh
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Selecting Paper Options in Windows

Follow these steps to select paper options on the Paper tab:

1 Create your image or document in your application software.

2 Access the printer settings dialog box as described in Printing
from Windows.

3 Click the Paper tab. You see the Paper dialog box:

Main  Paper |Layoul| Lltility | CIICk to SeIeCt
Paper Size your Paper
Size
Letter
il Page graphics
| e change to
e ™ Collate
_ _ o show Collate
Printer graphic and Reverse
- Orientation R
reﬂeCtS Changes o Portrait '8} Landscape Order SettlngS
to Orientation and || T Botse by a0
. | o
Printable Area I Rotate by 180
. ' Standar £ Magimum I I
settings - i‘ e e is not available
entered .
with
'EPSON | Windows 3.1
0K Cancel Help
]
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Note:

If the Reduce/Enlarge
setting is set to
Normal and you
select one of the
paper sizes to the
right that is marked
with an asterisk (*),
you see a dialog box
asking you to select a
paper size that fits
your printer. See
Reducing and
Enlarging Your
Document Size for
more information.

Advanced Printing

Click the Paper Size drop-down list to select the size of paper

you loaded in the printer.

The sizes marked with an asterisk (*; not available with
Windows 3.1) are larger than you can load in the printer and
can be used only with the Reduce/Enlarge setting on the
Layout tab; see Reducing and Enlarging Your Document Size

for more information.

A4 210 x297 mm

B5 182 x 257 mm

A5 148 x 210 mm

Letter 8 1/2 x11 in

Legal 8 1/2 x14 in

Executive 7 1/4 x10 1/2 in
Half Letter 51/2 x8 1/2 in
A6 Index card 105 x148 mm
Index card 5 x8in

Index card 8 x10 in
Envelope #10 4 1/8 x9 1/2 in
Envelope DL 110 x220 mm
Envelope C6 114 x162 mm

Envelope 132 x220 mm
Photo Paper 4 x6 in
Panoramic 210 x594 mm
B4 257 x364 mm *
USB11x17in *

A3 297 x420 mm *

Super A3/B 329 x483 mm *
B3 364 x514 mm *

A2 420 x594 mm *
USC17x%x22in *

User Defined (See Creating
User Defined Paper Sizes for
instructions.)

If you did not or cannot select the number of copies you want to
print in your application program’s Print dialog box, choose the
number in the Copies box. Don't select the number of

copies here and in your application’s Print dialog box; you

may get twice the number of copies you want.
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Note:

The Rotate by 180 °
setting lets you print
the lower portion of a
document first, with a
bottom margin as
small as 0.12 inch (3
mm) and a top margin
as small as 0.55 inch
(14 mm). This option
is not available with
Windows 3.1.

When you select
Maximum as the
Printable Area
setting, print quality
may decrease in the
expanded printable
area in the bottom
margin.

Advanced Printing

6

Portrait

If you're printing multiple copies of a multi-page document and
you want the copies printed in sets, click the Collate checkbox.
The page graphics change to show collated documents.

If you're printing a multi-page document and want the last page
printed first so the pages come out without needing to be
reordered, click the Reverse Order checkbox. The page
graphics change to show later pages printing first.

Select the direction of printing on the page with the Orientation
options. To print your document oriented as shown in one of
the following illustrations, select the options listed below it.

Landscape and
Rotate by 180°

Portrait and Landscape

Rotate by 180°

9 The Standard Printable Area setting uses the maximum

printable area of your paper with a minimum bottom margin of
0.55 inch (14 mm). To increase the minimum bottom margin to
0.12 inch (3 mm), set the Printable Area setting to Maximum .
To center your document on the page using either setting,
select the Centered checkbox.
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10 Click a tab for the settings you want to check or change next, or
click OK to print your document.

Creating User Defined Paper Sizes

You can create up to 10 custom paper sizes (one in Windows 3.1)
and add them to the Paper Size list using the User Defined option.
This is useful if you're printing a custom size document, such as a
banner. You can select any width from 3.5 to 9.5 inches, and any
height (length) from 3.5 to 44 inches.

Follow these steps to create a User Defined paper size:

1 Follow the steps in Printing from Windows to access the printer
software, then click the Paper tab.

2 Click the Paper Size list and scroll to the bottom of it using the
arrows or scroll bar.

3 Click the User Defined option. You see one of the following
dialog boxes:

= User Defined Paper Size

Paper Width 8.50] inches
[ 0. %50] Paper Height 1 inches

Paper Height Wj
[ 350... 4400] | OK I | Cancel I
Save Delete | ’VUr”“tum;m & 00%inch
Caesl Windows 3.1
Windows 95, 98, NT
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Note:

In Windows 95, 98,
and NT, the Paper
Width and Paper
Height units are in
hundredth of an inch
(or centimeter)
increments. For
example, 850 equals
8.50 inches.

Advanced Printing

Windows 95, Windows 98, or Windows NT

Type a name (up to 24 characters) for your custom paper size
in the Paper Size Name field. Then select a Paper Width and
Paper Height for the paper. To use centimeters instead of
inches, click the 0.01cm option. When you're finished, click
Save. The paper size name appears in the Paper Size listin
the dialog box. Add more sizes if you want, and click OK when
you're done.

Windows 3.1

You can create only one User Defined paper size. Type the
width in the Paper Width field and the length in the Paper
Height field. Then click OK.

You see the Paper tab again. The paper size name you defined
is added to the Paper Size list and selected as the current
setting. (In Windows 3.1, the setting is named User Defined .)

Click a tab for the settings you want to check or change next, or
click OK to print your document

To change or delete a custom paper size:

Windows 95, Windows 98, or Windows NT

Click User Defined in the Paper Size list. Then, on the User
Defined Paper Size dialog box, select the custom paper name in
the Paper Size list and change the Paper Width , Paper Height ,
and/or Unit settings as necessary, or click Delete. Click OK when
you're done.
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Windows 3.1

You can change the custom paper size, but cannot delete it. Click
User Defined in the Paper Size list. Then, on the User Defined
Paper Size dialog box, change the Paper Width and Paper Height
settings as necessary. Click OK when you’re done.

Selecting Paper Options on a Macintosh

The Paper Size and Orientation options for your printer software
are on the Page Setup dialog box. The options for collating and
reversing the page order are on the Layout dialog box. Follow the
steps in these sections for selecting the paper options:

» Choosing Paper Size and Orientation Options

» Selecting Print Order Options
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Setup dialog box:

Choosing Paper Size and Orientation Options
Follow these steps to select the Paper Size and Orientation :

1 Create your image or document in your application software.
2 Open the File menu and select Page Setup . You see the Page

Printer graphic
reflects changes
to Orientation —
and Printable
Area settings

[ oK |

Click to select

Paper Size: [ Letter [¥]

cncel ) | your Paper Size

Orientation: . Portrait Landscape

[ Rotate by 180 degrees

Click to select your

Reduce or Enlarge: %

Printable Area: @ Standard () Maximum
[ centered

Orientation options

Click to select

your Printable
Area options

Advanced Printing

loaded in the printer.

A4 210 x 297 mm

B5 182 x 257 mm

A5 148 x210 mm

Letter 8 1/2 x11 in

Legal 8 1/2 x14 in

Executive 7 1/4 x10 1/2 in
Half Letter 51/2 x8 1/2 in
A6 Index card 105 x148 mm

3 Click the Paper Size pop-up list to select the size of paper you

Index card 5 x8in

Index card 8 x10in
Envelope #10 4 1/8 x9 1/2 in
Envelope DL 110 x220 mm
Envelope C6 114 x162 mm
Envelope 132 x220 mm
EPSON Photo Paper 4 x6 in
Panoramic 210 x594 mm
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Note:

The Rotate by 180 °
setting lets you print
the lower portion of a
document first, with a
bottom margin as
small as 0.12 inch

(3 mm) and a top
margin as small as
0.55 inch (14 mm).

When you select
Maximum as the
Printable Area
setting, print quality
may decrease in the
expanded printable
area in the bottom
margin.

Advanced Printing

If you don’t see the exact size you need, you can create a
custom paper size; see Creating custom paper sizes.

4  Select the direction of printing on the page with the Orientation
options. To print your document oriented as shown in one of
the following illustrations, select the options listed below it.

Portrait Portrait and Landscape Landscape and
Rotate by 180° Rotate by 180°

5 The Standard Printable Area setting uses the maximum
printable area of your paper with a minimum bottom margin of
0.55 inch (14 mm). To increase the minimum bottom margin to
0.12 inch (3 mm), set the Printable Area setting to Maximum .
To center your document on the page using either setting,
select the Centered checkbox.

6 To collate multiple copies of a multi-page document or reverse
the order in which pages are printed, see Selecting Print Order
Options for instructions.

If you've finished selecting options, click OK to close the Page
Setup dialog box. Then select Print from the File menu to print
your document.
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Creating custom paper sizes

You can create up to 8 custom paper sizes and add them to the
Paper Size list. This is useful if you're printing a custom size
document, such as a banner. You can select any width from 3.5 to
9.5 inches, and any height (length) from 3.5 to 44 inches.

Follow these steps to create a custom paper size:

1 Open your application’s File menu and select Page Setup .
2 Click the Customize button. You see the following dialog box:

EPSON
Faper Size: R New Paper Size
N
]

3 Click the New button. Width and Height fields and Inches and
cm radio buttons appear on the screen.

4  Type the width and length of your custom paper in the Width
and Height fields. If you need to change from inches to
centimeters, click the correct radio button.

5 Type a name for your paper size in the New Paper Size field,
then click OK. The name is added to the Paper Size list and
selected as the current setting in the Page Setup dialog box.
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6 To delete a custom paper size, click the Customize button.
Then click the name of the custom paper size, and click Delete.
Click OK to return to the Page Setup dialog box.

Selecting Print Order Options
Follow these steps to use the Collate and Reverse Order options:

1 Open your application program’s File menu and select Print .
2 Click the [&] Layout icon. You see the Layout dialog box:

EPSON —J
-
r (L Fit to Page
@& orff Qon
Note: Papersize: [letter  |-|
For information on - [ watermark
- ame; ione hi elete
the other settings on ame: - Ltone_|7) = (BduDetete]
the Layout dialog ntensity: P —
box, see Choosing Lettor 1 print Layout
Print Layout Options ~ £ Print order Pages:  (1Page 7] .
on a Macintosh. Do order o —

Print Order options

3 If you're printing multiple copies of a multi-page document and
you want the copies printed in sets, click the Collate checkbox.
The page graphics change to show collated documents.
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Note:

Layout options are not
available with
Windows 3.1.

Advanced Printing

4 If you're printing a multi-page document and want the last page
printed first so the pages come out without needing to be
reordered, click the Reverse Order checkbox. The page
graphics change to show later pages printing first.

5 Click OK to close the Layout dialog box.

Selecting Print Layout Options

The print layout options let you reduce or enlarge almost any size
document to print on your printer. You can also select options to
proof multiple pages on one sheet of paper, add page frames, and
add a predefined or custom watermark.

Follow the steps in the section for your operating system:

» Choosing Print Layout Options in Windows
» Choosing Print Layout Options on a Macintosh

Choosing Print Layout Options in Windows

Follow the steps in these sections to use options in the Layout
dialog box:

» Reducing and Enlarging Your Document Size

» Using Multiple Print Layouts and Page Frames
» Adding a Watermark
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Reducing and Enlarging Your Document Size

When you want to make the printed size of a document different
from its actual size, you can use your printer software’s
Reduce/Enlarge settings. You can make the document fit into the
printable area on a selected paper size or you can choose to
reduce or enlarge it to a selected percentage.

Follow these steps to reduce or enlarge your document size:

1

Follow the steps in Printing from Windows to access the printer
settings dialog box, then click the Paper tab.

Click the Paper Size list and select the actual size of the
document you want to print.

For example, if your document size is 11 x 22 inches, select
US C 11 x 22 in. This paper size is too large to fit in your
printer, so you'll need to proportion it to fit on a smaller paper
size (by reducing the document size). If your document size is
5 x 8 inches, but you want it to fit in the maximum area on
Letter-size paper, you'll need to proportion it to fit on a larger
paper size (by enlarging the document size).

If the Paper Size setting you selected for your document is
within the maximum paper size that can fit on your printer, but
you want to enlarge or reduce the document, you need to
select the reduction/enlargement manually. Go to step 5.
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4 If the Paper Size setting you selected is larger than the
maximum size that can be printed on your printer, you see the
following dialog box:

Paper Settings

Document cannot be printed on this paper size.
Fleaze select a paper size to enable the Fit to Page
feature.

Output Paper
list

Output Paper  [[REEE AR

()8 I Cancel |

In the Output Paper list, select the actual size of the paper
loaded in the printer and click OK. This automatically turns on
the Fit to Page setting so the document fits into the printable
area on the output paper you select.

The selected Paper Size, reduction percentage, and Output
Paper settings now appear above the printer graphic.

Paper Size ——— [&5¢

setting / L 46
L ether

reduction

percentage

Output Paper
setting
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If you want to adjust the proportions or sizes, go to step 5. If
you're ready to print, go to step 7.

5 Click the Layout tab. You see the Layout dialog box:

Reduce/Enlarge
settings




Note:

If you previously
selected a Paper Size
setting that is larger
than the maximum
paper size for your
printer and then
choose Normal , the
Paper Size changes to
Letter 8 1/2 x 11 in .

Advanced Printing

6 Select one of the following Reduce/Enlarge settings:
» Select Normal to set the print proportion to 100%.

» Select Fit to Page to automatically reduce or enlarge the
document to fit on the paper size loaded in the printer. The
Paper Size option beneath the Fit to Page setting becomes
active; select the size of paper loaded in the printer.

— Reduce/Enlarge
" Momal (& FithoPage  Custam
Baper Size Select Fit to Page,
Letter 51/2 5 11 in | | [ thenselect the size
. of paper loaded in
|45 il .
Salelc | e the printer here

» Select Custom , then select a percentage (10% to 400%) in
the Scale to: field to reduce or enlarge the document by a
specific amount.

7 If you're finished selecting Layout options, click OK.

If you want to select more options, see Using Multiple Print
Layouts and Page Frames.
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Using Multiple Print Layouts and Page Frames

If you're printing a multiple page document, but you want a quick
proof of the images on each page printed on one piece of paper,
you can select Print Layout options in the printer software. You can
choose the way the pages are placed on the paper and add a lined
frame to each page, if you want.

Follow these steps to use the Print Layout options:

1 Follow the steps in Printing from Windows to access the printer
settings dialog box.

Click the Layout tab. You see the Layout dialog box.

3 To print multiple pages of your document on one sheet of
paper, select either the 2 Pages or 4 Pages radio button.

Frint Layout )
£ 1 Page & FEaues Click a buttor_1 to
.................. select a multiple
page print layout

[" Piint page frames ~ Page Order... |

4 Ifthe page order of the layout shown in the on-screen graphic is
how you want your document printed, go to step 3.

To change the page order, click the Page Order button. Then
select the page order you want to use from the Print Layout
dialog box that appears.
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Note:

To add a custom
watermark, you must
first create the
watermark as a bitmap
in an application
program that can
create bitmap files.
See your application’s
documentation for
instructions.

If you selected a
multiple page print
layout option (as
described in Using
Multiple Print Layouts

and Page Frames),
your watermark will
appear on each page
in the layout.

Advanced Printing

5 If you want to frame each page’s contents with a black line, one
dot wide, click the Print page frames checkbox.

6 Ifyou're finished selecting Layout options, click OK. If you want
to select more options, see Adding a Watermark.

Adding a Watermark

You can add a watermark to each page in your document to
emphasize its purpose or indicate how the document should be
handled. For example, you may want to add a watermark of the
word “Confidential” to documents you don’t want distributed to other
parties. Or you can add a custom bitmap of your company logo so
your document looks like printed letterhead.

Follow these steps to add a watermark:

1 Follow the steps in Printing from Windows to access the printer
settings dialog box.

2 Click the Layout tab. You see the Layout dialog box.
3 To select a watermark, click in the WaterMark drop-down list.
W atertd ark

[Nere [ — WaterMark _
drop-down list

SEtings... |
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See how your
selections will
look in the
Layout
graphic

\

Then highlight one of the following watermarks:

Do Not Copy

For Your Eyes Only
Review Copy

Top Secret
Duplicate

Confidential
Draft
Urgent
Priority

Hot

To turn off your watermark, select None from the drop-down

list.

To change the watermark or specify how it appears, click the
Settings button. You see the following dialog box:

Watermark Settings

Intensity

0K I Cancel

Watermark  |[BERREREE]

Click here to select a
predefined watermark

Click here to load a
custom watermark

Light |, J ., Dak

you've created

Specify how you want
your watermark to look
using these options

Hep |

5 To load a custom watermark you’ve created as a bitmap file in
an application program, click the User Defined button.

Advanced Printing
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You see the following dialog box:

! List :
Note: Click Browse to select
You can create up to — your bitmap file
10 custom watermarks.

Then type a name

In Windows 95 and 98, —
you can use any e (e
Itmap Tile up to .
15MB in siz6, With —J =]/ and click Save
Windows NT, the file
can be any size. Click the Browse button. You see a file selection dialog box.
Navigate to the folder containing the bitmap file you want to
To delete a custom use, select the file, and click OK.

watermark from the list,

click the User Defined Type a name for the custom watermark (up to 24 characters

button, select the long) in the Watermark field. Click the Save button to add it to
watermark, and click the list, then click OK.
Delete. The custom watermark now appears as the selected watermark

in the Watermark Settings dialog box and is shown in the
on-screen graphic.
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Note:

If your monitor
displays only 16
colors, the Intensity
adjustments are not
shown in the Layout
graphic. If you choose
the No Halftoning
setting, the Intensity
setting does not
determine how your
watermark is printed.

Advanced Printing

Now select the way you want the watermark to appear by
choosing the following options. The on-screen graphic changes
to reflect all the settings you choose.

Position selects where you want the watermark to appear
on your page: Center, Top-Left, Top-Center , Top-Right ,
Left, Right, Bottom-Left , Bottom-Center , or
Bottom-Right .

Size adjusts the size of the watermark, either larger or
smaller, as you move the slide bar.

Color lets you choose a color for your predefined
watermark: Red, Black, Blue, Aqua, Lime, Fuchsia , or
Yellow . You cannot select a color for a custom watermark;
it is printed in its original colors.

Intensity sets the lightness or darkness of the watermark
(from 5% to 100%) based on where you move the slide bar.

If you're finished changing Layout options, click OK to close the
Layout dialog box.
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Choosing Print Layout Options on a Macintosh

Follow the steps in these sections to use options in the Layout
dialog box:

» Using the Fit to Page Option

» Using Multiple Print Layouts and Page Frames

» Adding a Watermark

Using the Fit to Page Option

When you want to make the printed size of a document different
from its actual size, you can use your printer software’s Fit to Page
option to proportion it to fit in the maximum, centered area on a
selected paper size.

Follow these steps to use the Fit to Page option:

1 Create your image or document in your application software.

2 Open the File menu and select Page Setup . You see the Page
Setup dialog box.

3 Click the Paper Size list and select the actual size of the
document you want to print. For example, if your document
size is 8 1/2 x 11 inches, select Letter for the Paper Size
option.
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Advanced Printing

If you want to print this document on 4 x 6-inch EPSON Photo
Paper, you'll use the Fit to Page setting to reduce the
document to that size. If you want to print this document on
Legal-size paper (8 1/2 x 14 inches), you'll use the Fit to Page

setting to enlarge the document to that size.
Click OK to close the Page Setup dialog box.

Now open the File menu and select Print. You see the printer

settings dialog box.

Click the |&| Layout icon. You see the Layout dialog box:

EPSON

Letter

p - [ collate
@ . [ Reverse Order

- q Fit to Page
@® off Q on
paper size: [Totier 7]

r [ watermark ——M8M
Name: None | |Add/Delete
G

r [ Print Layout

9 prin rger N —

Page Order: | Left to Right [~]

O Print page frames

Fit to Page
settings

7 Select one of the following Fit to Page options:

» Select Off to set the print proportion to 100%.

» Select On to automatically reduce or enlarge the document
to fit on the paper size loaded in the printer.
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The Paper Size option beneath the Fit to Page setting
becomes active.

cI: Fit to Page

@ 0n ) Off
Paper Size : [ EPSON Photo Paper...[ |

Select the paper size you've
loaded in the printer here

Letter > EPSON Photo Paper ... Paper graphic displays the selected
L papersize and
document size

Now select the size of the paper you've loaded in the
printer. This automatically sets the correct reduction or
enlargement percentage to fit the document into the
printable area on the selected paper size. The selected
document size and paper size settings now appear beneath
the paper graphic.

8 If you're finished selecting Layout options, click OK.

If you want to select more options, see Using Multiple Print
Layouts and Page Frames.
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Using Multiple Print Layouts and Page Frames

If you're printing a multiple page document and you want a quick
proof of the images on each page printed on one piece of paper,
you can select Print Layout options in the printer software. You
can choose the way the pages are placed on the paper and add a
lined frame to each page, if you want.

Follow these steps to use the Print Layout options:

1 Open an application and select a document to print.

2 Open the File menu and click Print. You see the printer
settings dialog box.

3 Click the [@] Layout button. You see the Layout dialog box.

4  To print multiple pages of your document on one sheet of
paper, select either 2 Pages or 4 Pages in the Pages pop-up
list.

:# Print Layout Click the arrow and

Pages : [ 2 Pages R4 select a multiple page
Page Order : [ Left to Right [~] print layout

[ Print page frames

5 If the page order of the layout shown in the printer graphic is
how you want your document printed, go to step 6.

To change the page order, click the arrow in the Page Order
pop-up list. Then select the page order you want to use.
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Note:

To add a custom
watermark, you must
first create the
watermark as a PICT
file in an application
program that can
create PICT files. See
your application’s
documentation for
instructions.

If you selected a
multiple page print
layout option (as
described in Using
Multiple Print Layouts

and Page Frames),
your watermark will
appear on each page
in the layout.

Advanced Printing

6 If you want to frame each page’s contents with a black line, one
dot wide, click the Print page frames checkbox.

7 Ifyou're finished selecting Layout options, click OK. If you want
to select more options, see Adding a Watermark.

Adding a Watermark

You can add a watermark to each page in your document to
emphasize its purpose or indicate how the document should be
handled. For example, you may want to add a watermark of the
word “Confidential” to documents you don’t want distributed to other
parties. Or you can add a custom PICT file of your company logo so
your document looks like printed letterhead.

1 Open an application and select a document to print.
2 Open the File menu and click Print .

3 Inthe printer settings dialog box, click the |&| Layout button.
You see the Layout dialog box.

4 To use one of the predefined watermarks, click the arrow in the
Name list in the Watermark box and choose one of these:

Confidential Do Not Copy

Draft For Your Eyes Only
Urgent Review Copy
Priority Top Secret

Hot Duplicate

Go to step 6.
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Note:

You can create up to
10 custom watermarks
from PICT files up to

1MB in size.

To delete a custom
watermark from the
list, click the
Add/Delete button,
select the watermark,
and click Delete.

Advanced Printing

5 Toload a custom watermark you've created as a PICT file in an

application program, click the Add/Delete button. You see the
following dialog box:

EPSON e )

Watermark Lists Mark Name

| Click the Add button
to select a PICT file

1]

Click the Add button. You see a dialog box for selecting files.
Navigate to the folder containing the PICT file you want to use,
select the file, and click Open.

The name of your PICT file appears in the Mark Name field and
is added to the Watermark List. Click the Save button to close
the dialog box.

The custom watermark now appears as the selected watermark
in the Layout dialog box and is shown in the layout graphic.

Now select the way you want the watermark to appear by
choosing the following options. The layout graphic changes to
reflect all the settings you choose.

» Color lets you choose a color for your predefined
watermark: Red, Black, Blue, Aqua, Lime, Fuchsia , or
Yellow . You cannot select a color for a custom watermark;
it is printed in its original colors.
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Note:

If your monitor
displays only 16
colors, the Intensity
adjustments are not
shown in the Layout
graphic. If you
choose the No
Halftoning setting,
the Intensity setting
does not determine
how your watermark
is printed.

Advanced Printing

v

Intensity sets the lightness or darkness of the watermark
(from 5% to 100%) based on where you move the slidebar.

To adjust the size and position of the watermark, move the
cursor over the Layout graphic. Four boxes appear in the
corners of the graphic and the cursor changes to a hand.

Click and drag

I | | I— anywhere in here to
] move the watermark
€-|.F| .
. — Click and drag one of

| the corner boxes to
resize the watermark

To move the watermark, click anywhere inside the graphic
and drag it into one of these positions: center, top-center,
upper-right, middle-right, lower-right, bottom-center,
upper-left, middle-left, or lower-left.

To resize the watermark, move the cursor over one of the
corner boxes; the cursor changes to a pointing hand. Click
and drag the box corner to reduce or enlarge the
watermark.

If you're finished changing Layout options, click OK to close the

Layout dialog box.
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Using Print Preview on the Macintosh

You can get a preview of how your document will print with the Print
Preview feature in your Macintosh printer software. Print Preview
shows the results of the following printer software settings on your
document:

» Print layout settings such as Fit to Page , Page Order,
Watermark , Reverse Order , and Collate

» Page Setup options, such as Paper Size, Orientation , Rotate
by 180°, and Printable Area

1 Open an application and select a document to print.

Open the File menu and click Print. You see the printer
settings dialog box.

Click the Print Preview icon

|
EPSON SC 740 5.50E @ 7 The P”nt button

Copies:lil Pages: @ All Q I:l ~ I:l Changes tO the

Current Settings

Ink Preview button
ediaType: g || o

{ [ No Watermark

Mode | 7§ PrintLayout: None

) 1 i
3 Custom .
i =% High Speed: 0n
[ Advanced.. | (Custom Settings [~] | @ Color Adjustment
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Page control Ai (5] e 1/

buttons

Preview

image

Preview sizing

L

buttons

Advanced Printing

3 Click the Print Preview icon. The Print button changes to

the Preview button.

4  Click the Preview button. You see the print preview dialog box:

5

Help, Cancel,
and Print buttons

The first preview page is the first page of your document. To
change the preview page, click the [<] or [¥] button to go back
or forward one page, or enter a page number in the Page field.

To change the size of the preview, click the following buttons:
» Click B to preview the entire page in the display area

» Click ] to enlarge the preview

» Click M to enlarge the preview even further

To print your document, click Print. To close the print preview
dialog box and return to your application, click Cancel .
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Saving Custom Settings

After you've fine-tuned your printer settings for a special project,

you can save the settings as a group. Then you can quickly reuse
them the next time you print a similar project. You can save up to
10 (Windows) or 8 (Macintosh) groups of settings.

1 Customize your printer settings, then access the Advanced
dialog box as described in Customizing Print Quality and

Special Effects.

(In Windows 3.1, access the main printer settings dialog box as
described in Printing from Windows, then click Advanced .)

2 Click the Save Settings button. You see this dialog box:

Custom Settings.__

List -

Hame I
Save I LelEte | Qancell

EPSON

Custom Settings

Name

&

<

Cancel

Delete

Windows

Macintosh

3 Type a unique name for your settings (up to 16 characters) and

click the Save button.
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4 Click OK to close the Advanced dialog box (not necessary with
Windows 3.1).

To use the settings, click Custom (in Windows 3.1, click
Advanced) . Then open the Custom Settings list and double-click
the name you selected for your custom settings group. (On a
Macintosh, the custom settings group is automatically selected.)

To redefine or delete your custom settings, see Redefining Custom
Settings or Deleting Custom Settings.

Redefining Custom Settings

To change the options in a customized settings group but keep the
same name for it, follow these steps:

1 From the main printer settings dialog box, click Custom (in
Windows 3.1, click Advanced) . Then select the name of the
custom settings group you want to redefine in the Custom
Settings list.

2 Click the Advanced button (in Windows 3.1, click More
Settings ) and change the printer settings. (If you change the
Media Type and Ink settings, you'll need to create a new
custom setting group instead of redefining an existing one.)

3 When you're finished redefining settings, click Save Settings .
(In Windows 3.1, click OK to close the More Settings dialog box
and the click Save Settings on the main printer settings dialog
box.)
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4  Select the name of the custom settings group you're redefining
in the Custom Settings dialog box.

5 If you're using Windows, click Save. You see the Save As
dialog box. Click OK to save your redefined settings. (Click
Cancel to cancel your changes.)

On a Macintosh, click the Redefine button. Then click Replace
at the confirmation dialog box to save your redefined settings.
(Click Cancel to cancel your changes.)

Deleting Custom Settings

1 From the main printer settings dialog box, click Custom, then
click the Advanced button. Click Save Settings on the
Advanced dialog box. (In Windows 3.1, click Advanced , then
click Save Settings on the main printer settings dialog box.)

2 Select the custom settings group in the Custom Settings box,
and click Delete. Then click OK to confirm the deletion, if
necessary. (You cannot delete any of the predefined document

types.)
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Printing on Special Media

Your EPSON Stylus COLOR 740 lets you print on just about any
kind of paper you want to use. You can get great results printing on
various sizes of plain paper, letterhead, and envelopes, but you'll
get even better results with specially coated ink jet paper.

For the best output, use EPSON'’s photo-quality paper: ink jet
paper, glossy paper, glossy film, note cards, and photo paper. For
special projects, you can use a variety of EPSON media designed
for ink jet printers, ranging from transparencies to iron-on transfer
paper.

Follow the steps in this chapter on:

» Selecting Special Media

» Media Loading and Handling Guidelines
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Selecting Special Media

When you print on special media, you need to choose the correct

Media Type and Paper Size settings in your printer software. The
table below lists the available EPSON media and the corresponding
Media Type setting for each one.

Media name Size Part number Media Type setting

EPSON 360 dpi Ink Jet Paper Letter S041060 360 dpi Ink Jet
A4 S041059 Paper

EPSON Cool Peel Iron-On Letter S041153/S041155

Transfer Paper

EPSON High Quality Ink Jet Paper | Letter S041111 Photo Quality Ink
A4 S041117 Jet Paper

EPSON Photo Quality Ink Jet Letter S041062

Paper A4 S041061
Legal S041067

EPSON Photo Quality Ink Jet A6 S041054

Cards 8 x 10 inches S041122

EPSON Ink Jet Note Cards (with | A6 S041147

envelopes)

EPSON Photo Quality Self A4 S041106

Adhesive Sheets

Printing on Special Media
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Media name Size Part number Media Type setting
EPSON Photo Quality Glossy Letter S041124 Photo Paper
Paper A4 S041126
EPSON Photo Paper 4 x 6 inches S041134
Letter S041141
A4 S041104
Panoramic S041145
EPSON Photo Quality Glossy Film | Letter S041072 Photo Quality
A4 S041071 Glossy Film
A6 S041107
EPSON Photo Stickers Kit A6 S041144-KIT
(CD-ROM and paper)
EPSON Photo Stickers (refill) A6 S041144
EPSON Ink Jet Transparencies Letter S041064 Ink Jet
A4 S041063 Transparencies
EPSON lron-On Transfer Paper Letter SE41001

To order EPSON papers and other media, contact your dealer or
call EPSON Accessories at (800) 873-7766 (U.S. sales only). In
Canada, please call (800) 873-7766 for dealer referral.

Printing on Special Media
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Caution:

Don't use the cleaning
sheets that may be
included with your
special media; they
may jam inside the
printer.

Printing on Special Media

Media Loading and Handling Guidelines

The following tips help you get the best results on any type of
paper:

Always handle sheets by the edges, and don’t touch the
printable surface.

When you load paper, make sure the printable side is
facing up.

You can load paper up to the arrow mark on the left edge
guide.

Return unused sheets and envelopes to their original package
as soon as possible. See Paper for more storage information.

If your paper package included protective sheets, cover the
printed side of your paper with these sheets before stacking
your paper.

Use ink jet papers within one year of purchase. Use glossy
media and transparencies within six months.

Follow any specific instructions for your paper in the following
sections:

» Letterhead, Preprinted Forms, and Legal-size Paper

» EPSON Photo Quality Glossy Paper, Film, and
Transparencies

» Envelopes
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» EPSON Photo Paper
» EPSON Photo Quality Ink Jet and Note Cards
» EPSON Photo Stickers

» EPSON Photo Quality Self Adhesive Sheets
» EPSON Iron-On and Cool Peel Iron-On Transfer Paper

Letterhead, Preprinted Forms, and Legal-size Paper

Load the top edge first. When you load long paper, pull up the
paper support extension and both output tray extensions.

EPSON Photo Quality Glossy Paper, Film, and
Transparencies

Before you load glossy film or transparencies, put a support sheet
(packed with the media) or a plain paper sheet beneath the stack.
(Don’t use a support sheet with Photo Quality Glossy Paper.)

You can load up to 20 sheets of glossy paper or glossy film, or up to
30 transparencies.

On Photo Quality Glossy Film, you may get better results by loading
one sheet at a time. With multiple sheets loaded, the minimum top
margin you can use is 1.2 inches (30 mm). If you want to use a
smaller top margin, load and print one sheet at a time.
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If your media has a cut corner, position it in the printer as shown
here.

Click the picture on
the right to play a
short movie.

Note:

It is best not to use
the Maximum
printable area setting
in the printer software
when printing on
paper with a cut
corner. Part of your
document may print
in the cut out area.

Remove each sheet from the output tray immediately after it's
printed. Make sure each sheet is dry before stacking.
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Envelopes

You can load up to 10 envelopes flap edge first, with the printable
side up, as shown below:

Click the picture on
the right to play a
short movie.

Note:

If the stack of
envelopes is more
than 0.4-inch

(20 mm) thick, press
the envelope edges
to flatten them before
stacking or load one
envelope at a time.

Select Plain paper as the Media Type and choose the correct
envelope size as the Paper Size setting in the printer software.
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If ink smears when you print on envelopes or other thick media, set
the paper thickness lever to the + position as shown below. (Return
the lever to the 0 position before printing on other media.)

Click the picture on
the right to play a
short movie.
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Note:

To keep your
printouts looking their
best, store them in a
resealable plastic bag
or other airtight
covering and protect
them from heat,
humidity, and direct
sunlight.

Be sure to support
your Panoramic
Photo Paper as it
ejects from the printer
so it doesn't fall onto
the floor.

Printing on Special Media

EPSON Photo Paper

You can use EPSON Photo Paper to print photographs that look
almost as good as the ones you get from film processing. 4 x 6-inch
Photo Paper is perforated around the edges, so you can trim your
printouts and “bleed” the photo—extend it to the edge of the
paper—on all sides.

You can load up to 20 sheets of 4 x 6-inch, Letter-size, or A4-size
Photo Paper or 1 sheet of Panoramic paper at a time. Make sure
you place a support sheet beneath the paper if it is included in the
paper package.

Keep the following in mind when using EPSON Photo Paper:

» Load the paper with the whiter (glossier) side facing up.

» If you're loading Panoramic Photo Paper, pull up the paper
support extension. Then load the Panoramic paper and hold up
its top edge while you press the [¥J load/eject button to feed it
into the printer.

Select Photo Paper as the Media Type setting and
Panoramic 210 x 594 mm as the Paper Size setting.
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» Ifyou're loading 4 x 6-inch Photo Paper, follow these steps:

1 Position the perforated margins as shown and load up to
20 sheets with support sheets A and B beneath the stack.

2 When you create the image you'll print in your application
software, size it to 4.25 x 6.25 inches so the image covers

the perforations as shown.
0.67 in

L

0.24in __|
0.12in —1|

| Trim size

_+— Printed image size

7

0.12in 0.24in

Printing on Special Media
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Tip

You can use

4 x 6-inch EPSON
Photo Paper like a
postcard. After
printing on the glossy
side of the Photo
Paper, let your image
dry completely.

Then set the paper
thickness lever to the
+ position, reload the
flattened card with
the uncoated side up,
and print your
message in black ink
using 360 dpi Ink Jet
Paper as the Media
Type setting.

Printing on Special Media

3

4

Choose these printer software settings:

Photo Paper as the Media Type setting
EPSON Photo Paper 4 x 6 in as the Paper Size setting
Maximum as the Printable Area setting

After you print, fold the paper back and forth along the
perforations and carefully tear the margins off.
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EPSON Photo Quality Ink Jet and Note Cards

You can load up to 30 cards at a time. Always place the included
support sheet under the cards and load them as shown below.

Make sure you set the paper thickness lever to the + position as

shown in Envelopes. When you're ready to print, set the Media
Type to Photo Quality Ink Jet Paper and the Paper Size setting to

the card size in your printer software.
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EPSON Photo Stickers

Use these sheets of stickers to print small, decorated photos for
use on cards, invitations, or other items. You’'ll need to use an
application that can create photo stickers, such as StickerPix™

Load one sheet of Photo Stickers at a time. Make sure to place
support sheets A and B that came with the stickers beneath the
sheet.

When you're ready to print, select Photo Quality Glossy Film as
the Media Type setting and A6 Index card 105 %148 mm as the
Paper Size in your printer software.

EPSON Photo Quality Self Adhesive Sheets

Use these sheets to print labels or stickers. You can load one sheet
at a time. Make sure your adhesive sheets are fully adhered to their
backing sheet before you load them.

When you're ready to print, select Photo Quality Ink Jet Paper as
the Media Type setting in your printer software.
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EPSON Iron-On and Cool Peel Iron-On Transfer
Paper

You can print photos, company logos, or anything else you want on
these transfer papers, and then iron your images onto T-shirts or
other cloth items.

Load one sheet of transfer paper at a time. For Iron-On Transfer
Paper, select Ink Jet Transparencies as the Media Type setting.
For Cool Peel Iron-On Transfer paper, select 360 dpi Ink Jet
Paper as the Media Type setting.

Make sure you reverse your image before you print it—especially if
it includes text—so it will read correctly when it's transferred. You
can use the Flip Horizontal setting in your printer software to do
this (see Customizing Print Quality and Special Effects for
instructions).

After you print, follow the instructions that came with the paper to
iron the image onto the shirt or other item.
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Managing Print Jobs

Your printer software includes several utilities for managing print
jobs. You can use them to monitor your printer’s status and check
on the current print job or jobs waiting to print.

This chapter provides instructions for the following:

» Managing Print Jobs in Windows 95, Windows 98, and
Windows NT 4.0

» Managing Print Jobs in Windows 3.1
» Managing Print Jobs on a Macintosh
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- Managing Print Jobs in Windows 95,
Tig Windows 98, and Windows NT 4.0

Your printer software offers three ways to manage and monitor your

Windows NT 4.0 print jobs:
servers and

workstations include
a messenger service
to alert you to printer

» Progress Meter, which appears each time you send a print job,
as described in Checking Printer Status. You can turn the
Progress Meter on or off and select other printing options using

errors or let you know the Speed & Progress button; see Selecting the Speed &
when a print job is Progress Options for details.

finished. If you have » Spool Manager (not available with Windows NT), which
apprOp”aFe.net‘Nork appears in the taskbar at the bottom of the screen each time
access pr'v'leges or you print, as described in Using the Spool Manager.

you're controlling

printing from the » Status Monitor 2, which provides a variety of print monitoring
server, you can also options, as described in Using Status Monitor 2.

set other options. See
your Windows NT
documentation for
details.
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Selecting the Speed & Progress Options

You can set up the way your printer software sends print jobs and
displays the Progress Meter using the Speed and Progress dialog
box. To access the dialog box, you must open your printer software
from the Windows Printers utility as described below.

1 Click Start, point to Settings , then click Printers .

2 Right-click the EPSON Stylus COLOR 740 printer icon and
select Properties (Windows 95 and 98) or Document Defaults
(Windows NT) from the menu.

3 Click the Utility tab. You see the Utility menu:

Eenerall Dela\\sl I Maml tah Paperl % Layout & Util‘lﬂ—i Utlllty tab

| EPSOM Status Monitor 20w

Use this utility to automatically check. for emrars
and also check the level of ink remaining.

% Mozzle Check(J]
Use this utility if gaps or faint areas appear in

MO priftaut,

Head Cleaningl[)

Use this utility if pour print quality declines or
the Nozzle Check indicates cloaged nozzles.

Print Head lignment(v)

Usze this utility if misaligned vertical ines
appear in your printout

Prinker and Option Infarmation(P)

-
]
Use this utiliby to make or verify settings for

our pritter and optional devices.
e e . Speed &
m _SpeedbProges: Pro g ress
0k | ceeel | i | Hep | button

4 Click the Speed & Progress button.
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You see this dialog box:

Speed & Progress

v V¥ Show Progress Meter

fim

| Not available with
High zpeed [D4)] transfer enabled. WindOWS NT

—High Speed Copy Folder

o windowshtemp

If you have more than

= b

(= windows one hard disk drive,
= el —— you can select a folder
£ whe for storing multiple

copy print jobs here.
: You don't see this box
== [ if you have only one

Lo e e hard disk drive.

Select the following options:

» High Speed Copies speeds up printing of multiple copies
of the same document using hard disk space as a cache.

» Show Progress Meter lets you control whether or not the
Progress Meter is displayed when you send a print job. See
Checking Printer Status for information on the Progress
Meter.
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» EPSON Printer Port (not available with Windows NT 4.0)
lets you optimize the transfer rate of your printer port for
EPSON printers instead of using the Windows default
printer port. You may see one of these messages beneath
the EPSON Printer Port option:

» High speed (DMA) transfer enabled tells you that
you're already using fast DMA transfer mode.

» For higher data transfer rates, use DMA transfer  lets
you know that you can speed up printing by enabling
DMA transfers on your system. See your computer
documentation or contact your computer’s technical
support for instructions on using DMA transfers, if your
computer supports them.

If you see no message, you cannot enable DMA transfers
on your system.

5 Click OK to close the Speed & Progress dialog box and return
to the Utility menu. Then click OK again to exit your printer
software.
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Using the Spool Manager

The Spool Manager (not available with Windows NT) creates a
temporary print job file and stores it in the C:\TEMP or
C:\WINDOWS\TEMP folder. The software then sends the file to
your printer at the right time.

To open Spool Manager while you're printing, click the EPSON
Stylus COLOR 740 button that appears on the taskbar at the
bottom of the screen. You see the Spool Manager window:

Document Mame | Paper Size | Statug | Progress | Started At
5 Bogtiog et Letter Plain paper Printing 0of 6 Page 111859 8M 1/

@ {Cancel | Pause/Resume | Restart | Help... |
I

Print job file Command buttons

The Spool Manager window displays the status of your print job
files and lets you control them. To cancel, pause, resume, or restart
a print job, click the job to highlight it; then click the corresponding
command button on the bottom of the window.
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Note:

You can check printer
status using Status
Monitor 2 only when
your printer is
connected directly to
your computer on a
bidirectional port.

Managing Print Jobs

Deleting a Stalled Print Job

If you're having trouble printing, it may be because of a stalled print
job. Follow these steps to delete it and continue printing:

1

2
3
4

Click the EPSON Stylus COLOR 740 button on the taskbar.
Click on any print jobs marked Held.

Click the Cancel button.

Exit Spool Manager and try printing again.

Using Status Monitor 2

Status Monitor 2 lets you view detailed information about your print
jobs and control how you want printing monitored. Before you can
use Status Monitor 2, you must enable background monitoring for
your printer if it isn’t already enabled.

Follow the instructions in these sections:

Enabling Background Monitoring

Setting Up Monitoring Preferences

Using the Status Monitor 2 Main Window

Using the Printer Status Window

Using the Job Status Window
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Note:

Background
monitoring must be
turned on to change
the Background
Monitoring and Status
Alert preferences.
See Enabling
Background

Monitoring for
instructions.

Managing Print Jobs

Enabling Background Monitoring

To turn on background monitoring, follow these steps:

1

Click Start, point to Programs , click the Epson folder, and
click EPSON Status Monitor 2 .

Click EPSON Stylus COLOR 740 in the Printer Name list. The
name is highlighted.
Open the Settings menu and select Background Monitoring

Select either Monitor from restart  (to begin background
monitoring after your next system restart) or Monitor now (to
begin background monitoring right away).

Now set your monitoring preferences for the printer as
described in Setting Up Monitoring Preferences.

Setting Up Monitoring Preferences

You can select the way you want Status Monitor 2 to monitor your
printer using the Monitoring Preferences window. There are several
ways to open the window:

Click the printer name in the Installed Printers list to highlight it
and click the | icon or select Monitoring Preferences from
the Settings menu.

Right-click the printer name in the Installed Printers list and
select Monitoring Preferences from the drop-down menu.
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Turn background
monitoring on or off
for the selected
printer

Managing Print Jobs

You see the Monitoring Preferences window:

Monitoring Preferences =]

— Manitaring |nterwal

Short .—J— Long

Setting a short monitaring interval may cause some
applications ta run maore slawly.

— Background Manitoring

v Monitar this printer

Status Alert

™ Shaw when printing
™ Show when enors oceur

[~ Show when consumables are law

Cancel |

|__ Set the length of the interval in

which you want Status Monitor 2
to monitor your printer here
(short intervals may cause some
applications to run slower)

Select if and when to use

| the Status Alert dialog

box: while printing, when
errors occur, and/or when
ink is low

If you turn on one or more of the Status Alert options, you'll see the
Status Alert dialog box when the selected condition occurs. For
example, if you turn on Show when errors occur , the dialog box
appears only if a printing error occurs. If you select all the options,
the dialog box appears whenever you print, encounter an error, or
have low ink levels.
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Managing Print Jobs

The color of the printer icon in the Status Alert dialog box indicates
the type of error, as described in Interpreting the Installed Printer

icon.

Click the printer name to
highlight it, then click

EFSOM Status Monitor 2

Printer Mame ar Path

| Status

1 EPSON Stylus COLOR

Details to open the Printer
Status window; see Using
the Printer Status Window
for more information

Using the Status Monitor 2 Main Window

Printing...

|

(=i |

oK
|

Click here to close the
Status Alert dialog box

Once you've enabled background monitoring for your printer and
set up your monitoring preferences, there are two ways to access

Status Monitor 2:

» Double-click the i icon on the taskbar in the bottom right

corner of your screen.

» Click Start, point to Programs , click the Epson folder, and

click EPSON Status Monitor 2 .
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Menu bar
Button bar

Installed
Printer icon
and name

You can change the
shape of the Status
Monitor 2 printer icon
by clicking the Select
background
monitoring icon in
the Settings menu
and selecting the icon
you want to use.

Managing Print Jobs

When you start Status Monitor 2, you see the main window:

JFEPSON Status Monitor 2 1S [=] E3
Seltings  Hel

Pl ] = e .

;‘IJ@L. )] CEll Printer Name, Status,

PnnlelNam!e I‘Slal!us IJnhlLum | and JOb Count tltle bars

[ EFSON Siglus COLOR Ready o Printing. 0

The number of print
jobs waiting to print
appears here
Brief status
messages appear

Operating | e 7 here

If you have more than one printer you want to monitor, you can add
them using the Add Printers option in the Settings menu. To save
system resources, you may want to delete any printers from the
Status Monitor 2 list that you don’t need to monitor. To do this, click
the printer in the Installed Printers list and select Delete Printer
from the Settings menu.

You can customize the appearance of items on the Status

Monitor 2 main window using the View menu options or using icons
on the button bar. If you're monitoring multiple printers, you can
reorder them in the Installed Printers list by clicking in the Printer
Name, Status, or Job Count title bar.
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Other options in Status Monitor 2 let you view more details on the
printer or job status, as described in Using the Printer Status

Window and Using the Job Status Window.

Interpreting the Installed Printer icon

The color of the Installed Printer icon indicates the printer status as
follows:

Installed Printer

icon color Status message

Green Ready to print

Yellow Paper and/or ink level is low

Red Paper and/or ink is out, paper is jammed, or a print

error has occurred

Gray or dimmed | A communication error has occurred (check your
cable connections)

Using the Printer Status Window

For more details on the status of your printer, you can use the
Printer Status window. There are several ways to open the window:

» Double-click the printer name in the Installed Printers list.

» Click the printer name in the Installed Printers list to highlight it
and click the &| icon or select Printer Status from the Printer
menu.

Page 106



» Right-click the printer name in the Installed Printers list and
select Printer Status from the drop-down menu.

» If you're currently using the printer software, click the Utility
tab, then click the EPSON Status Monitor 2 icon.

» You can also access the Printer Status window by clicking the
Details button on the Progress Meter (see Checking Printer
Status) or the Status Alert dialog box (see Setting Up
Monitoring Preferences).

You see the Printer Status window. The Current Status tab gives
printing status and error correction information.

. . @ Current Status onsumables Tinter Informatian
lllustrations of what to do if an @Mgd;t [ e
error occurs appear here Pintia
e B Printer status
. . . messages
If your printer runs out of ink, j 9
click this button to display o escelnkCaniae If an error occurs,
cartridge replacement steps troubleshooting tips
on the right and illustrations in £l appear here
the printer graphic area [ ox | cowed | Heb |

Managing Print Jobs Page 107



Managing Print Jobs

The printer graphic in the Printer Status window gives status and
error condition information:

Graphic

Condition

Ready to print

Paper isn't loaded correctly

Paper is jammed

Black ink is out

Color ink is out

A communication error has occurred

Another type of printer error has occurred
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Note:

The Job Status
window is very similar
to the Spool Manager
window. Both allow
you to pause, cancel,
and restart print jobs.
See Using the Spool
Manager for more
information.

Managing Print Jobs

To check the amount of ink you have, click the Consumables tab.

G Cument Status § G Consanables | @ Printer faimton |

@ @ These graphics indicate the

amount of ink remaining in
your cartridges

0| Caned | Heb |

(The Printer Information tab doesn’t display information for your
printer.)

Using the Job Status Window

To view detailed information on the print jobs waiting to print, you
can use the Job Status window (not available with Windows NT).
There are several ways to open the window:

» Click the printer name in the Installed Printers list to highlight it
and click the |g] icon or select Job Status from the Printer
menu.

» Right-click the printer name in the Installed Printers list and
select Job Status from the drop-down menu.
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You see the Job Status window:

M e n u Printer Document  Yiew Help
Document Hame | Stalus | Owner | Frogiess | Started At |
bar ] papplab Piing -Sp.. Objlesol 0. 20823 PM 1/28/9

1 jobs i queue 4

Information on jobs currently printing or waiting to be
printed appears here

Options in the Printer menu let you pause printing or purge all
waiting print jobs, select or deselect the printer as your Windows
default, and access the printer software to change default settings.

The Document menu options let you pause or cancel printing of
individual print jobs. First click the print job you want to pause or
cancel in the Document Name list to highlight it.
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Managing Print Jobs in Windows 3.1

Your Windows printer software includes two management utilities:
the Spool Manager and Despooler.

» The Spool Manager starts automatically when you send a job to
the printer. It allows you to print in the background while you
continue to work on your computer and to hold jobs to print at a
later time. If you're using your printer on a network, it also
handles multiple print jobs that come in at the same time. See
the next section for detalils.

» The Despooler also starts automatically when you send a job to
the printer. It displays on your screen to provide printer status
information. See Checking Printer Status for details on the
Despooler.

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. When
you send a job to your printer, your printer software creates a
temporary print job file, stores it in the C:\TEMP or
C:\WINDOWS\TEMP directory, and assigns it to a print queue. The
software then sends the file to your printer at the right time.

Managing Print Jobs Page 111



Note:

You may not see the
Spool Manager icon if
Program Manager or
the current window is
maximized. Reduce
the window size to
see the Spool
Manager icon.

Managing Print Jobs

To open Spool Manager, do one of the following:

» To open it while you're printing, click the EPSON Spool
Manager icon at the bottom of your desktop.

» You can open Spool Manager at any time by double-clicking
the Spool Manager4 icon in the EPSON program group.

You see the Spool Manager window:

= EPSON Spool Manager ! -
Queue View Options Help
Printer/Document Name | Status | Size | Time
+
PS0 0l OR 0 P A B
& Write - README.WRI Printing page 1 27 pages {263 1:54 5/6/98
‘ +

Queue Print job file

The Spool Manager window displays the status of your print job
files and lets you control them. You can also control print queues,
display of the Despooler, and the default spool directory. Click Help
in the Spool Manager menu bar for detailed information.
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Deleting a Stalled Print Job

If you're having trouble printing, it may be because of a stalled print
job. Follow these steps to delete it and continue printing:

1

4

Open the Spool Manager as described in Using the Spool
Manager.
Click on any print jobs marked Held.

Open the Document menu and click Delete. Then click Yes.

Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message while printing, or printing is very slow,
you can try changing your default spool directory.

1

Make a directory on your hard drive where you want Spool
Manager to store print job files, for example, CASPLTEMP.

Open the Spool Manager as described in Using the Spool
Manager.

Make sure EPSON Stylus COLOR 740 is selected, and then
choose Setup from the Queue menu. The Queue Setup dialog
box appears.

Change the spool directory to the one you created in step 1.
Also make sure Use Print Manager for this port is checked.
Then click OK.
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Note:

You can also select
background printing
options before you
print. See Setting Up
Background Printing
Options for more
information.

Managing Print Jobs

Choose Default Spool Directory from the Options menu.

In the dialog box, change the spool directory to the one you
created in step 1. Then click OK.

Close Spool Manager.

Managing Print Jobs on a Macintosh

Your Macintosh printer software includes two print job management
utilities: Monitor3 and Status Monitor. It also includes a
Configuration utility for setting up print monitoring options.

If you're using background printing, Monitor3 starts
automatically when you send a job to the printer. It handles
printing while you continue to work on your Macintosh, lets you
track documents that are waiting to be printed, and lets you set
priorities and print times for waiting print jobs.

The Status Monitor alerts you to any problems that occur during
printing. You can also use it at any time to see how much ink
you have left.

The Configuration utility lets you select how you want to be
notified of printer errors and where you want print job files
stored.
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Using Monitor3

The Monitor3 utility lets you continue to work on your Macintosh
while your document is printing (however, background printing is
slower and may also slow down your system). You can then open
the Monitor3 dialog box to check on your print jobs and cancel,
pause, or restart them.

To use this utility, you need to turn on background printing and
increase the memory allocation for Monitor3, as described in
Setting Up Monitor3.

*“! Setting Up Monitor3
Note: 1 Open the Chooser from the Apple menu and select the SC 740
You can also turn on icon. Then select the port you're using.

background printing
while you're using
your printer software; 3 Toincrease the memory allocation, select EPSON Monitor3 in

2 Under Background Printing , click On and close the Chooser.

see Setting Up the Extensions folder in your System folder. Then choose Get
Background Printing Info from the File menu and set the Memory Requirements to
_Q%for 2000 or 3000, depending on your system'’s available RAM.
Instructions.

Managing Print Jobs Page 115



Monitoring Print Jobs with Monitor3

While you're printing, click the EPSON Monitor3 icon on the
Application menu at the right end of the menu bar. You see the
following dialog box:

[0 ==———————=FPSONMonittri =—ie————=H

Job currently [ mutHisa bt
P =l Copies:141 Status Processing job. sending data.. (3).

prlntlng u Pages:141 - ]
Jobs queued — Docul-nent N.ame Priority Paper Size Meéia Type | Printer Marne —
for prlntlng = ramnainadsy tif Morrnal Letter Flain Pa... (]
Click to set
priorities or print —
times for waiting ——{— show detaits 7
print jobs

You can track the printer’s progress with the current job, or
double-click a job and use these command buttons:

» click [@ to delete
» click | to restart
» click [m] to pause
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Note:

If you see a stop sign
icon and the message
Print queue on hold
in the EPSON
Monitor3 dialog box,
select Start print
gueue from the
Printer menu to
release the queue
and resume printing.

Managing Print Jobs

To set priorities for jobs waiting to print, click the job, then click the
Show details arrow at the bottom of the window.

mutldiag.tif
Copies:1/1 Status Processing job. sending data.. (3).
Pages:1/1 _—
Docurnent Narme Priority | Paper Size | Media Type | Printer Name
B rmmainady.tif Mormal | Letter Flain Pa... =
Ed
== Hide detailz
. . . Document Marne :mmainady i
Priority list box Priority Hormal B
Paper Size : Letter =
. Media Type : Flain Paper =l
Settings selected Copis 1 R
— Pages : 1
1 1 User : Macbeth
for the highlighted Drintstion : Partrt
. . watermark : Mone =
pr|nt JOb Print Layout : Mone ~

The Priority list becomes active. Click the arrow and select one of

the following settings:

» Normal prints the job in the order it is received

» Urgent moves the job before any Normal priority jobs in the

print queue

» Hold holds the job in the print queue until you're ready to
release it for printing by clicking the =] restart icon
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» Print Time opens the dialog box below so you can set a
specific print time; click OK after setting the day and time

Set Print Time

5/ 5082 (1130 M|

(o)

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your

printer. Follow these steps:

1 Choose Page Setup or Print from the File menu in your
application. You see a printer settings dialog box.

2 Click the [44] Utility icon. You see the Utility menu:

For information
about these
utilities, see
Maintenance and

Transportation

EPSON

EPSON StatushMonitor
% Use this utility to automatically check for errors

and also check the level ofink remaining.

Nozzle Check

Use this utility if gaps or faint areas appear in your
printout.

Nozzle Check indicates clogged nozzles.

Head Cleaning
Use this utility if your print quality declines or the

Print Head Alignment
Use this utility if misaligned vertical lines appear

in your printout.

B

Configuration|
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3 Clickthe EPSON StatusMonitor

icon. The software checks the

amount of ink remaining in the printer and displays the Status

Monitor window:

EPSON

EPSON StatusMonitor

—Inkr

ing level

L] Black

148 Color

I
i

—Installed ink cartridge information —

Click to recheck the
ink level

4 To recheck the ink level check, click the Update button. To
close the Status Monitor dialog box, click OK.

Managing Print Jobs
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Selecting Configuration Options

You can configure the way you want the printer to handle error and
warning messages, ink level checks, and temporary spool folders in
the Configuration Settings dialog box. Follow these steps:

1 Choose Page Setup or Print from the File menu in your
application. You see a printer settings dialog box.
Click the Utility icon. You see the Utility menu.

3 Click the Configuration button. You see the Configuration
Settings dialog box:

o EPSON Configuration Settings
Prlntlng StOpS When Error notification
these messages appear — <|:© Beep and text {3 Text only ‘

. . ~Warning
Printing continues when @ Beep and text O Tent only
these messages appear Temporary Spool folder

. . . HD 500:...:5pool Folders -_Selecl... ‘

Spooled print job files are— {

. T High § d Copi Told
stored in these folders [Hf,";',’,ﬂf_a_:ﬂp;ﬂ, feiasa ‘
. [ Check for errors before starting to print.
Click here to check for  — || qcneck the ik tevel before starting o print.

errors and/or the ink level Defquit
before printing

Click here to select the default settings
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4  Select the configuration options you want as follows:

» Error notification lets you select whether you want your
system to beep and display error message text or just
display text if your printer encounters an error.

» Warning lets you choose whether warning messages beep
and display text or display text only.

» Temporary Spool folder and Temporary High Speed
Copies folder let you select the folders on your hard disk
that store the temporary print job and high speed
multiple-copy print job files created when you send a job to
the printer. Click the Select button to change the folder from
the default folder shown.

» Click the Check for errors before starting to print
checkbox if you want your software to check for errors
before starting your print job.

» Click the Check the ink level before starting to print
checkbox if you want your software to check for a low ink
condition before starting your print job.

5 When you're finishing changing your configuration options,
click OK to return to the Utility menu.
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Maintenance and
Transportation

It's easy to keep your EPSON Stylus COLOR 740 printer working at
its best. Just follow the simple instructions in this chapter for:

» Replacing an Ink Cartridge
» Cleaning the Print Head

» Aligning the Print Head

» Cleaning the Printer

» Transporting the Printer
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Replacing an Ink Cartridge

When the & black or & color ink out light flashes, the indicated
cartridge is low on ink. This is a good time to make sure you have a
new cartridge. When the light stays on, the cartridge is empty and
you need to replace it.

Use these EPSON ink cartridges within six months of installing
them and before the expiration date on the package:

To ensure good Black ink cartridge S020189
results, use genuine Color ink cartridge S020191

EPSON cartridges When you need new ink cartridges, contact your dealer or call
and do not refil EPSON Accessories at (800) 873-7766 (U.S. sales only). In

them. Other products  canada, please call (800) 873-7766 for dealer referral.
may cause damage

Caution:

to your printer not If you need to replace an ink cartridge before the lights flash
covered by EPSON’s  (because the ink is too old, for example) follow the instructions in
warranty. Replacing an Outdated Ink Cartridge.
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Removing and Installing Ink Cartridges

You can replace a cartridge when the & black or & color ink out
light is either flashing or on. (If you press the & cleaning button
when both ink out lights are off, the printer cleans the print heads,
as described in Cleaning the Print Head.)

Play this movie for an overview of the installation process. Then
follow the steps on the next page to replace your cartridges.

Click the picture on
the right to play a
short movie.
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Caution:

You must remove the
yellow tape from the
top of the cartridge or
you will permanently
damage it. Do not
remove the clear seal
from the bottom of
the cartridge; ink will
leak out.

To avoid damaging
the printer, never
move the print head
by hand.

Maintenance and Transportation

Follow these steps to replace ink cartridges:

1
2

Remove the new ink cartridge from its packaging.

Remove only the yellow part of the tape seal on top as shown
below. Don'’t pull off the blue portion or try to remove the
clear seal underneath the cartridge

Remove the
yellow tape

Black cartridge Color cartridge

Make sure the printer is turned on and not printing, then open
the printer cover.

Press the & cleaning button and hold it for about three
seconds until the print head moves left and the O power light
begins flashing.

(The print head returns to its home position if you don’t proceed
to step 5 within 60 seconds.)
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Caution:

Don’t open the clamp
or remove a cartridge
except to replace it
with a new one. Once
you remove a
cartridge, you can't
reuse it, even if it
contains ink.

Warning:

If ink gets on your
hands, wash them
thoroughly with soap
and water. If ink gets
into your eyes, flush

them immediately
with water.

5 Pull up the ink cartridge clamp. The cartridge rises up from its
holder.

6 Lift the cartridge out of the printer and dispose of it carefully.

7 Lower the new ink cartridge into its holder with the label facing
up and toward the back of the printer.

8 Press down the ink cartridge clamp until it locks in place.
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9 If you need to replace the other ink cartridge, repeat the
preceding steps before going on to step 10.

10 Press the 4% cleaning button and close the printer cover.

The printer moves the print head and begins charging the ink
delivery system. (Even if you don't press the button, ink
charging begins 60 seconds after you close the clamp.)

Caution:
Never turn off the
printer while the

O power light is The O power light flashes, and the printer makes various
flashing, unless the sounds. Charging takes a couple minutes. When it's finished,
printer hasn’t moved the O power light stops flashing and stays on.

or made any noise for
more than 5 minutes.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need to
replace it. How can you tell? You may notice that your printouts
don’t look as good as they used to. If print quality doesn’t improve
after cleaning and aligning the print head, you can replace one or
both cartridges.

Follow these steps to replace an ink cartridge before the & black or
& color ink out light is flashing or on:

1 Prepare your new ink cartridge for installation as described in
Removing and Installing Ink Cartridges.

2 Make sure the printer is turned on and not printing, then open
the printer cover.
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Caution:

To avoid damaging
the printer, never
move the print head
by hand.

Never turn off the
printer while the

O power light is
flashing, unless the
printer hasn't moved
or made any noise for
more than 5 minutes.

Press the [ load/eject button and hold it down for three
seconds until the print head moves to the left. The O power
light begins flashing.

Remove the old ink cartridge and install the new cartridge as
described in Removing and Installing Ink Cartridges. Don’t
press any control panel buttons, however.

Press the [ load/eject button and close the printer cover.

The printer moves the print head and begins charging the ink
delivery system. The O power light flashes and the printer
makes various sounds. Charging takes a couple minutes.
When it's finished, the O power light stops flashing and stays
on.
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Cleaning the Print Head

If your printed image is unexpectedly light or faint, or dots are
missing from the image, you may need to clean the print head. This
unclogs the nozzles so they can deliver ink properly.

Cleaning the print head uses ink, so clean it only if print quality
declines. You can clean the print head in either of the following
ways:

» With the Head Cleaning utility in your printer software (when
connected to a local port, not over a network)

» Using the printer’s control panel buttons

Using the Head Cleaning Utility

Follow these steps to run the Head Cleaning utility:

1 Make sure the printer is turned on but not printing, and the
& black and & color ink out lights are off.

2 Start an application and open a document.

Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

4  Click the Utility tab (Windows) or the Utility icon
(Macintosh). You see the Utility menu.

5 Click the Head Cleaning icon.
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Caution:

Never turn off the
printer while the

O power light is
flashing, unless the
printer hasn’t moved
or made any noise for
more than 5 minutes.

Follow the instructions on the screen to clean the print head.
Cleaning takes a couple minutes, during which the printer
makes some noise and the O power light flashes.

When the O power light stops flashing, run a nozzle check to
test the results and reset the cleaning cycle.

Make sure paper is loaded in the printer and click Print nozzle

check pattern (Windows) or Confirmation (Macintosh). Then
click Next. The nozzle check pattern prints on your printer; see
Examining the Nozzle Check Pattern for details.

If the nozzle check pattern is complete, click Finish .

If the pattern is missing dots, click Clean to run another
cleaning cycle. If you don’t see any improvement after cleaning
two or three times, check the print quality solutions in Improving

Print Quality.

Using the Control Panel

Follow these steps to clean the print head:

1

Make sure the printer is turned on and not printing, and that the
& black and & color ink out lights are off.

Press the & cleaning button and hold it down for three
seconds. Cleaning takes a couple minutes, during which the
printer makes some noise and the O power light flashes.
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3 After the O power light stops flashing, print a page to test the
print quality and reset the cleaning cycle.

If you're connected directly to the printer, run a nozzle check.
Go to step 4.

Caution:

If you're using DOS or printing over a network, open an
application and print a document containing black and color
data. Then go to step 8.

Never turn off the
printer while the
O power light is

flashing, unless the 4  Start an application, open a document, and access the printer
printer hasn’t moved settings dialog box as described in Printing from Windows or
or made any noise for Printing from a Macintosh.

more than 5 minutes. . . . S
5 Click the Utility tab (Windows) or the Utility icon

(Macintosh). You see the Utility menu.

6 Make sure paper is loaded in the printer and click the Nozzle
Check icon, then click Next. The nozzle check pattern prints on
your printer; see Examining the Nozzle Check Pattern for
details.

7 If the nozzle check pattern is complete, click Finish .

If the pattern is missing dots, click Clean to run another
cleaning cycle.

8 If you don't see any improvement after cleaning two or three
times, check the print quality solutions in Troubleshooting.
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Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look
something like this, with the lower pattern colored magenta, cyan,
and yellow:

=S————————
sS——————————

Each staggered horizontal and straight vertical line should be
complete, with no gaps in the dot pattern. If your printout looks
okay, you're done. If any dots are missing, as shown below, clean
the print head again; see Cleaning the Print Head for instructions.

Missing dots
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to
align the print head using the Print Head Alignment utility in your
printer software. Your printer must be connected to a local port, not
Caution: on a network, to use this utility. Follow these steps:

Load paper that's at
least 8.27 inches
(210 mm) wide. This 2 Start an application and open a document.
prevents ink from
spraying inside the
printer and smudging
your printouts. 4  Click the Utility tab (Windows) or the Utility icon (Macintosh).

You see the Utility menu.
For the best Its, . . . .
Io(;rd EePS%SNrﬁ]SkujeSt 5 Click the Print Head Alignment icon.

1 Make sure the printer is turned on and paper is loaded.

3 Access the printer settings dialog box as described in Printing
from Windows or Printing from a Macintosh.

paper in the printer 6 Follow the instructions on the screen to print a test page and
whenever you check select the correct alignment.

the print head

alignment.
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Caution:
Don't touch the gears
inside the printer.

Never use alcohol or
thinner for cleaning;
they can damage the
printer components
and case.

Don’t use a hard or
abrasive brush.

Don't get water on the

printer components.

Don't spray lubricants

or oils inside the
printer.

Cleaning the Printer

To keep your printer working at its best, you should clean it several
times a year, following these steps:

1 Turn off the printer, unplug the power cord, and disconnect the
printer cable.

2 Remove all the paper from the sheet feeder.
3 Clean the exterior of the printer with a soft, damp cloth.
Clean ink out of the printer’s interior with a soft, damp cloth.
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Transporting the Printer

If you move your printer some distance, you need to prepare it for
transportation in its original box. Follow these steps:

1 Turn on the printer and wait until the print head locks in the far
right position. Then turn off the printer.

2 Unplug the power cord from the electrical outlet. Then
disconnect the interface cable from the printer.

Caution:

To avoid damage, 3 Remove any paper from the printer and remove the paper
always leave the ink support.

cartridges installed 4 Push in the output tray extensions and close the tray.

when transporting

the printer. 5 Repack the printer and attachments in the original box using

the protective materials that came with it. See the Unpacking
Sheet that was packed with your printer.

Be sure to keep the printer level as you transport it. If you notice a
decline in print quality after transporting the printer, clean the print
head (see Cleaning the Print Head); if output is misaligned, align
the print head (see Aligning the Print Head).
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Troubleshooting

As you use your printer, you may occasionally experience a paper
jam or other problem. The first thing you should do is diagnose the
problem, following the guidelines in this chapter. Then try the most
likely solutions until the problem is fixed.

This chapter covers the following problems and solutions:

Diagnosing Problems

Improving Print Quality

Solving Printing Problems

Solving Printer Software Problems
Fixing Paper Problems

Solving Miscellaneous Printout Problems
Uninstalling Printer Software

Where To Get Help

Page 136



Troubleshooting

Diagnosing Problems

There are a number of ways to diagnose printer problems:

To identify the most common problems, check the printer’s
lights; see Checking the Control Panel Lights for details.

You can also view the Printer Status window to identify
common problems, if you installed Status Monitor 2 with
Windows 95, 98, or NT 4.0. For instructions, see Using the
Printer Status Window. On a Macintosh, you can check your ink
levels using the Status Monitor; see Using the Macintosh
Status Monitor for details.

To determine whether the problem is caused by the printer
itself, run a printer operation check. See Running a Printer
Operation Check for instructions.

If you see an error message about your printer settings or have
problems with color quality, you may need to confirm your
Printer ID number. See Confirming the Printer ID Number for
details.

For the latest information, check the Help programs and the
ReadMe files in the EPSON program group or folder.

If any of the suggested solutions in this chapter tell you to
uninstall and then reinstall your printer software, see
Uninstalling Printer Software for instructions.

If none of the suggested solutions here solve your problem,
contact your EPSON dealer or see Where To Get Help.
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Troubleshooting

Checking the Control Panel Lights

power power
button light

paper out light

black ink out light—}—= @

- ?
color ink out light ——= @) @ |

cleaning button load/eject button

Follow these guidelines when the control panel lights come on or
flash:

J When the @) paper out light flashes, paper is jammed
in the printer. Turn off the printer, remove all the paper
(including any pieces torn off inside), then reload the
stack. Turn on the printer and press the ¥ load/eject
button. For tips on avoiding paper jams, see Paper
jams inside the printer.

) When the @ paper out light comes on, your paper ran
out or is incorrectly loaded. Load paper in the feeder
and then press the [¥ load/eject button.

& or &  When an ink out light flashes, your ink supply is low.
Make sure you have a replacement cartridge.
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Troubleshooting

& or &)  When an ink out light comes on, you need to replace
the ink cartridge. See Replacing an Ink Cartridge for
instructions.

O O 6 & When the O power and @ paper out lights flash and
the & black and & color ink out lights come on,
jammed paper may be blocking movement of the print
head. See The O power and J_paper out lights are
flashing and the & black and &5 _color ink out lights are
on for more information.

G O & &) When all the lights flash, your printer may have an
internal error. See All the lights are flashing for more
information.

Running a Printer Operation Check

You can run a printer operation check to determine whether the
problem comes from the printer itself or some other source.

» If the results are satisfactory, the problem lies in your software
settings, the interface cable, or your computer.

» If the check page does not print correctly, you have a problem
with your printer. See the suggestions in this chapter for
possible solutions.

1 Make sure both the printer and computer are turned off.
Disconnect the interface cable from the printer.
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3 Make sure paper is loaded in the printer.

4 Hold down the ) load/eject button and press the ® power
button. Hold down the [ load/eject button until the ® power light
starts to flash, then release it.

Caution:

Load paper that's at
least 8.27 inches
(210 mm) wide. This 5 To end the check, turn off the printer. Then reconnect the
prevents ink from interface cable and turn on your printer and computer.
spraying inside the

printer and smudging

your printouts. Confirming the Printer ID Number

The printer prints its ROM version number and a nozzle check
pattern (shown in Examining the Nozzle Check Pattern).

If you're using Windows 95, Windows 98, or Windows NT, you can
use the Printer and Option Information utility to confirm the Printer
ID. Color quality may improve after you confirm the ID number.

If you're using Status Monitor 2, this information is updated
automatically. However, if a message appears prompting you to
enter settings or if you change the printer’s configuration, you'll
need to update the Printer ID manually. Follow these steps:

1 Make sure letter-size paper is loaded in your printer.

2 Access the main printer settings dialog box as described in
Printing from Windows.

3 Click the Utility tab. Then click the Printer and Option
Information icon.
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Troubleshooting

4

5

Click the Settings Sheet button. The printer prints the Printer
ID on a sheet of paper.

Make sure the Printer ID shown in the Printer and Option
Information dialog box matches the ID on the Settings Sheet. If
they don’t match, change the ID numbers in the dialog box to
match those on the Settings Sheet.

Click OK to exit and save your settings.

Improving Print Quality

If you find that your print quality has declined, you can often
improve it by doing one of the following:

Clean the print head following the instructions in Cleaning the
Print Head.

Use higher quality paper appropriate for your print job. See
Selecting Special Media for a list of EPSON papers.

Match the Media Type in the printer software to the type of
paper you loaded in the printer. Then the printer software can
automatically select other settings for the best quality. (See
Basic Printing and Selecting Special Media for details.)

Turn off High Speed mode in the Advanced dialog box, as
described in Customizing Print Quality and Special Effects.
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Make sure Economy mode is turned off in the printer software,
as described in Customizing Print Quality and Special Effects.

Check the status of the & black and & color ink out lights, then
replace the ink cartridges, if necessary, as described in
Replacing an Ink Cartridge.

Here are some detailed solutions to print quality problems.

The printed image has horizontal banding

Possible cause

Solution

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you're using. See
Printing from Windows or Printing from a Macintosh for instructions.

The printable side of
the paper is face down.

Remove the paper and reload it with the printable side face up. See
Media Loading and Handling Guidelines for instructions.

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are
low on ink.

Check the # black and &) color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.

The MicroWeave
option is not turned on.

Turn on MicroWeave (if available) in the Advanced dialog box. See
Customizing Print Quality and Special Effects for more information.

The Maximum
Printable Area setting is
turned on.

Select the Standard Printable Area setting to avoid banding in the
expanded margin area. See Selecting Paper Size and Orientation
Options for more information.

Troubleshooting
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Vertical lines are misaligned or vertical banding appears

Possible cause

Solution

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The paper thickness
lever is in the +
position.

Set the paper thickness lever to the 0 position and try printing again. See
Envelopes for instructions.

The High Speed
setting is turned on.

Turn off the High Speed setting if vertical lines are misaligned. See
Customizing Print Quality and Special Effects for information.

The print head is
misaligned.

Run the Print Head Alignment utility. See Aligning the Print Head for
instructions.

The printed image has incorrect or missing colors

Possible cause

Solution

The Ink optionis setto
Black .

Change the Ink setting to Color . See Printing from Windows or Printing
from a Macintosh for instructions.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you're using. See
Printing from Windows or Printing from a Macintosh for instructions.

The Halftoning and
Color Management
options are set
incorrectly for your
document type.

Use the correct settings for the project you're printing, following the
instructions in Customizing Print Quality and Special Effects and
Customizing Color Settings.

Troubleshooting
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Possible cause

Solution

The printable side of
the paper is face
down.

Remove the paper and reload it with the printable side face up. See
Media Loading and Handling Guidelines for instructions.

The ICM (Windows 95
or Windows 98),
sRGB (Windows 95,
98, NT), or ColorSync
(Macintosh) settings
are incorrect for your
document.

Use the Automatic mode setting or choose a different Rendering
Intent setting (Macintosh). See Advanced Printing for more information.

The print head nozzles
are clogged.

Clean the print head. See Cleaning the Print Head for instructions.

The ink cartridges are
low on ink or one or
more ink colors are
empty.

Check the & black and &0 color ink out lights to see which cartridge you
may need to replace. See Replacing an Ink Cartridge for instructions.

The colors displayed
on your monitor don't
match the printed
colors.

Because your monitor and printer use different technologies to represent
colors, your printed colors can’t exactly match the colors you see on your
monitor screen. Use the ICM (Windows 95 or Windows 98) or
ColorSync (Macintosh) settings to get as close a match as possible.
See Advanced Printing for more information.

The color settings in
your application
software need
adjustment.

You may be able to adjust various color settings in your application
software. See your software documentation for more information.
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The printed image is faint or has gaps

Possible cause Solution

The print head nozzles Clean the print head. See Cleaning the Print Head for instructions.
are clogged.

The Media Type Make sure the Media Type setting matches the paper you're using. See
setting doesn’t match Printing from Windows or Printing from a Macintosh for instructions.
the loaded paper.

The loaded paper is Remove the paper and reload a new stack with the printable side face
damaged, old, or dirty. up. See Media Loading and Handling Guidelines for instructions.

The ink cartridges are  Check the & black and &) color ink out lights to see which cartridge you
low on ink. may need to replace. See Replacing an Ink Cartridge for instructions.

The printed image is blurry or smeared

Possible cause Solution

The loaded paper is Remove the paper and reload a new stack with the printable side face
damaged, old, or dirty. up. See Media Loading and Handling Guidelines for instructions.

The paper thickness Set the paper thickness lever to the + position to print on envelopes or

lever is in the wrong other thick media; set the lever to the 0 position to print on other media
position. types. See Envelopes for instructions, then try printing again.

The paper is damp or  Remove the paper and reload a new stack with the printable side face
the printable side is up. See Media Loading and Handling Guidelines for instructions.

face down.

You loaded special Follow the special media loading instructions in Media Loading and
media without a Handling Guidelines and on the paper packaging for media that require
support sheet. support sheets. Also try loading your media one sheet at a time.
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Possible cause

Solution

You tried to print on
cardboard or other

non-recommended

media.

Make sure your paper or media meets the specifications listed in Paper.
If your printouts are still blurry after you change paper, clean the print
head as described in Cleaning the Print Head.

The Media Type
setting doesn’t match
the loaded paper.

Make sure the Media Type setting matches the paper you're using. See
Printing from Windows or Printing from a Macintosh for instructions.

Ink has leaked inside
the printer.

Clean carefully inside the printer to remove spilled ink. See Cleaning the
Printer for instructions.

You're using the High
Speed and
MicroWeave settings
with a misaligned print
head.

Turn off High Speed following the instructions in Customizing Print
Quality and Special Effects. Then run the Print Head Alignment utility
following the instructions in Aligning the Print Head.

The resolution of your
image may be too low.

If a photographic image looks grainy or rough, try using the
PhotoEnhance3 (PhotoEnhance on Windows 3.1) and Sharpness
setting to improve the printed quality. See Customizing Color Settings for
details. You can also increase the image resolution using your
image-editing software, or decrease the size of the image.
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All lights are off

Solving Printing Problems

If the printer won't print, first check that:

The printer is turned on and the O power light is on, but not
flashing.

Paper is loaded in the printer.

The printer is plugged into a working electrical outlet that's not
controlled by a switch or timer.

The interface cable is securely connected to the printer and
computer.

If you still can’t print, check the following solutions.

Possible cause

Solution

The printer is not
receiving power.

Try these solutions:

Make sure the printer is turned on.
Turn off the power and plug in the power cord securely.

Make sure the outlet is not controlled by a switch or timer and
is operable.
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Only the & power light is on, but nothing prints

Possible cause

Solution

The interface cable is
not connected
securely.

Turn off your printer and computer. Then make sure the cable is
connected securely and meets the printer’s specifications.

The printer has an
internal problem.

Turn off the printer and computer, disconnect the interface cable, and
run a printer check as described in Running a Printer Operation Check.

The printer or
application software is
installed incorrectly.

If the printer check works, make sure your printer and application
software are correctly installed. If you're printing on a network, you may
need to set up your printer for network printing, as described in the
Printer Basics book.

Your computer doesn’t
have enough memory
to handle the file you're
printing.

Try one of the following:

» Reduce the resolution of your image.

» Select fewer colors or a lower resolution for your display or monitor.
» Add more memory to your computer.

Printing is stalled.

In Windows, delete the stalled print jobs in Spool Manager; see Using
the Spool Manager for instructions. In Windows NT, uninstall the
EPSON Printer Port. Click Start, point to Programs , EPSON Printers ,
and select EPSON Printer Port Uninstall

On a Macintosh, delete stalled print jobs using Monitor3 (see Using
Monitor3) or open the Extensions folder, EPSON folder, and Spool
folder, and then delete any queued files.

The print head nozzles
are clogged or the ink
cartridges are too old.

Clean the print head; see Cleaning the Print Head for instructions. If
cleaning doesn't help, replace the cartridges. For information on
cartridge life and replacement instructions, see Replacing an Ink

Cartridge.
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The i paper out light is flashing or on

Possible cause

Solution

If flashing, paper is
jammed.

Remove the paper and follow the guidelines for preventing jams as
described in Paper jams inside the printer.

If on, paper is used up
or is loaded incorrectly.

Load paper or remove the stack and reload it as described in the Start
Here card and in Media Loading and Handling Guidelines. Then press
the [ load/eject button to turn off the @ paper out light and resume
printing.

A & black or & color ink out light is flashing or on

Possible cause

Solution

If flashing, the ink
supply is getting low.

You need to replace the indicated ink cartridge soon; see Replacing an
Ink Cartridge for instructions.

If on, the ink cartridge
is empty.

You must replace the indicated ink cartridge now to be able to print; see
Replacing an Ink Cartridge for instructions.

The O power and ) paper out lights are flashing and the & black and & color ink out

lights are on

Possible cause

Solution

Jammed paper may be
blocking movement of
the print head.

Turn off the printer, wait a few seconds, and turn it back on to eject any
paper. If no paper is ejected, turn off the printer, remove the jammed
paper, and turn it on again. If the lights are still flashing and on, contact
your EPSON dealer or see Where To Get Help.
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All the lights are flashing

Possible cause

Solution

You haven’t removed
all the packing material
from the printer.

Remove the tape and other packing material following the instructions
on the Unpacking Sheet.

An internal error may
have occurred.

Turn off your printer, wait a few seconds, and turn it on again. If the
lights still flash or stay on, contact your EPSON dealer or see Where To

Get Help.

The printer has finished charging the ink cartridge, but the O power light is still

flashing

Possible cause

Solution

The ink cartridge
clamp isn’t locked
down.

Press down the clamp to lock it.

Packing material
remains in the printer.

Remove the tape and other packing material following the instructions on
the Unpacking Sheet.

The printer needs to
initialize.

If the printer is not moving or making noise, but the & power light is still
flashing after more than 5 minutes, turn the printer off. If the light is still
flashing when you turn it back on, contact your EPSON dealer or see
Where To Get Help.
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Solving Printer Software Problems

If you have trouble with your printer software, first check that your
printer is selected as the default Windows printer or as the current
printer in the Macintosh Chooser.

If you still have problems with your printer software, check the
following solutions.

The printer software installed with Windows 3.1 doesn’t work correctly after you
upgrade to Windows 95 or Windows 98

Possible cause Solution

Your printer softwareis  Uninstall the printer software after installing Windows 95 or Windows 98,
not set up correctly for as described in Uninstalling Printer Software. Then reinstall it as

the new operating described in the Start Here card.

system.

After you install your printer software, you see the Windows 95 or Windows 98 New
Hardware Found window

Possible cause Solution
Windows has detected Click Do not install a driver , and then click OK. Never select any
your printer. other option on the New Hardware Found window.
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You see a spooling error message (Windows)

Possible cause

Solution

If you see error
messages or printing is
very slow, the problem
may be caused by
temporary files
(Windows 3.1 only).

Change the Spool Manager default directory (Windows 3.1 only),
following the instructions in Using the Spool Manager.

Your hard drive is too
full.

Delete unnecessary files to make room on the drive.

Your computer doesn’t
have enough memory
for the file you're
printing.

Try one of the following:

» Reduce the resolution of your image.

» Select fewer colors or a lower resolution for your display or monitor.
» Add more memory to your computer.

You see a memory error message (Macintosh)

Possible cause

Solution

You need to increase
the memory allocation
for your application,
EPSON Monitor3, or
both.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.

If that doesn’'t work, turn off background printing in the Chooser or in your
printer software; see Setting Up Background Printing Options for
instructions.You won’t be able to use Monitor3.
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In Windows 95, Windows 98, or Windows NT, the Status Monitor 2 window

doesn’t appear

Possible cause

Solution

You didn’t restart your
computer after
installing Status
Monitor 2.

Click Start, select Shut Down , click Restart the computer , and click
Yes to restart your computer. Then try using Status Monitor 2.

Bi-directional support
is not enabled.

Click Start, select Settings , and click Printers . Right-click the EPSON
Stylus COLOR 740 icon and select Properties . Click the Details tab,
then click the Spool Settings button. Click the Enable bi-directional
support for this printer  radio button to turn on bi-directional support.
Click OK twice, then close the Printers window and try printing again.

You're using
ScanDisk.

Before using ScanDisk, turn off background monitoring in Status
Monitor 2. (See Enabling Background Monitoring for instructions.) Then
turn it back on when you're finished using ScanDisk.
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Printing is too slow

Possible cause Solution

Your printer software For the fastest printing, try the following printer software settings:
options are set » Set Print Quality to Economy .

incorrectly. » Turn MicroWeave off.

» Turn High Speed on.
» Choose Black ink and No Halftoning .
See Advanced Printing for instructions.

Your system doesn’t
have enough

Clear space on your hard disk or run a defragmentation utility.

]
» Don’t run too many applications at the same time.
]
]

resources. Turn off virtual memory.

Increase your system’s memory (RAM) and/or processor speed.
You're using Choose Get Info from the File menu when the application is active or
background printing EPSON Monitor3 is selected and increase the memory requirements.
on a Macintosh. See Using Monitor3 for more information.

If that doesn’t work, turn off background printing in the Chooser or in
your printer software; see Setting Up Background Printing Options for
instructions.You won’t be able to use Monitor3.

You're not using ECP  If your computer supports ECP or Enhanced mode and/or DMA
or Enhanced mode transfers, turn them on to speed up printing. See your computer
and/or DMA transfers. documentation for details.
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Your printer switches to the modem port or won'’t confirm on the printer
port (Macintosh)

Possible cause Solution

Your Macintosh has Make sure AppIeTaIk® is inactive. In the Chooser, select any Apple serial

extension conflicts. printer (such as the LaserWriter) and choose the printer port. Close the
Chooser, then reopen it and select the SC 740 icon and the printer port.
Then restart your system.

You're using an Make sure you're using a standard Apple System Peripheral-8 cable.
AppleTalk cable. See Macintosh System Requirements for more information.

Your printer icon doesn’t appear in the Chooser (Macintosh)

Possible cause Solution

Your Macintosh has Disable Quick Draw GX in the Extensions Manager. Make sure EPSON
extension conflicts. Monitor3 and SC 740 are enabled, and then restart your Macintosh.

Your application program can’t open your image file (Macintosh)

Possible cause Solution

Not enough memory Highlight the program icon and select Get Info from the File menu, then
is allocated to the increase the memory allocated to the application.

application.
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The “SC 740 cannot be used” message appears (Macintosh )

Possible cause

Solutions

The printer software
has been corrupted.

Remove and reinstall the printer software as described in Uninstalling
Printer Software. Then, in the Extensions Manager, disable Quick Draw
GX, enable EPSON Monitor3 and SC 740, and restart.

Your printer doesn’t print correctly as a remote printer (Windows NT)

Possible cause

Solution

You may need to use
a different network
path and printer port.

Select a different printer port in the printer's Properties window and enter
the new network path to your printer at the DOS prompt. Then restart
your computer. See your Windows NT documentation for instructions on
changing the printer port and network path.

Troubleshooting

Fixing Paper Problems

To avoid most paper handling problems:

» Use smooth, high-quality media designed for ink jet printers
that meets the media specifications in Paper.

» Follow all loading and handling instructions included with the
media.

» Load the media with the printable side face up as described in
the Start Here card and in Media Loading and Handling
Guidelines.
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If you have any paper problems, check here for solutions.

Paper doesn’t feed
Try this Then do this

Remove the stack of Check that the paper isn't:
paper from the printer.

Curled or creased.

» Too old. (See Media Loading and Handling Guidelines or your
paper packaging for more information.)

» Loaded above the arrow on the left edge guide.

» Jammed inside the printer. (If the & paper out light is flashing,
paper is jammed.)

Then reload the paper against the right edge guide as described in the
Start Here card and in Media Loading and Handling Guidelines,
adjusting the left edge guide to fit the paper’s width.

Multiple pages feed at the same time

Try this Then do this

Remove the stack of
paper from the printer.

Make sure the paper isn’t too thin (see the specifications in Paper).

Fan all the edges of the stack of paper to separate the sheets.

» Reload the paper as described in the Start Here card and in Media
Loading and Handling Guidelines.

» If too many copies of a page or document are printing, check the

Copies settings in both the printer software and your application

program. See Selecting Paper Size and Orientation Options for

more information.
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Paper jams inside the printer

Try this Then do this

Turn off your printer, Load more paper in the printer, following the instructions in the Start
open the cover, and Here card and in Media Loading and Handling Guidelines. If your paper
remove all the paper jams frequently, make sure you:

that’s inside, including
any little pieces that
may have torn off.

Use smooth, high-quality paper, loaded printable side up.
Fan the stack and then even the edges before loading it.
Load paper beneath the arrow mark on the left edge guide.
Adjust the left edge guide to fit the width of your paper.

Paper doesn't eject fully or is wrinkled

Possible cause Solution

If the paper doesn't Press the ¥ load/eject button to eject the paper. Then make sure you
eject fully, you may select the correct paper size in your printer software. See Selecting
have set the wrong Paper Size and Orientation Options for instructions.

paper size.

If it's wrinkled when it ~ See the specifications in Paper for ranges of paper thicknesses you can
comes out, the paper  print with, as well as environmental requirements for storage.

may be damp or too

thin.
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Solving Miscellaneous Printout Problems

If your printout results are not what you expected, try these
solutions.

Characters are incorrect or garbled

Possible cause

Solution

Your printer is not
selected in your
application or as the
Windows default
printer.

Select your printer in your application or select it as the default Windows
printer. See your Windows documentation or online help for
instructions.

Your printer is not
selected in the
Macintosh Chooser.

Select your printer in the Chooser as described in the Start Here card.

Printing is stalled.

In Windows, delete the stalled print jobs in Spool Manager; see Using
the Spool Manager for instructions. In Windows NT, uninstall the
EPSON Printer Port. Click Start, point to Programs , EPSON Printers ,
and select EPSON Printer Port Uninstall

On a Macintosh, select the stalled print jobs in Monitor3 (see Using
Monitor3) or open the Extensions folder, EPSON folder, and Spool
folder, and delete any queued files.

Troubleshooting
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Possible cause

Solution

The interface cable
is not securely
connected.

Turn off your printer and computer. Then make sure the cable is
connected securely and meets the printer’s specifications.

Your video driver may
be conflicting with the
EPSON printer driver.

Change to a standard VGA driver (see your computer or video card
documentation for instructions). If your printout is correct, your video
driver is interfering with the printer driver. Contact your computer or
video card manufacturer for an updated driver.

The image is inverted as if viewed in a mirror

Possible cause

Solution

You used a Flip
Horizontal option.

Turn off the Flip Horizontal or mirror setting in your application software
or the printer software. See Customizing Print Quality and Special
Effects for instructions.

The image size or position is incorrect

Possible cause

Solution

The paper and/or
layout options are set
incorrectly.

Check the paper settings and the settings on the Layout dialog box
(Windows 95, 98, and NT, or Macintosh only). See Selecting Print
Layout Options for instructions. Also check the paper and layout options
in your application software.

Troubleshooting
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The margins are incorrect

Possible cause

Solution

Margins are set
incorrectly in your
application software.

Check your software documentation for instructions on selecting the
correct margins for your paper size and within its printable area. See
Printable area for more information.

Paper settings in the
printer software are
incorrect for your paper
size.

Check the paper size, orientation, printable area, and layout settings to
make sure they’re correct for your paper size. See Selecting Paper Size
and Orientation Options and Selecting Print Layout Options for more
information.

A portion of your image doesn’t print (Macintosh)

Possible cause

Solution

Your system doesn’t
have enough available
memory.

Close any other applications you are running and turn off background
printing as described in Setting Up Background Printing Options.

You need to increase
the memory allocation
for your application,
EPSON Monitor3, or
both.

Choose Get Info from the File menu when the application is active or
EPSON Monitor3 is selected and increase the memory requirements.
See Using Monitor3 for more information.

If that doesn’t work, turn off background printing in the Chooser or in
your printer software; see Setting Up Background Printing Options for
instructions.You won'’t be able to use Monitor3.

Troubleshooting
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The printer prints blank pages

Possible cause Solution
Your printer is not Select your printer in your application or select it as the default Windows
selected in your printer. See your Windows documentation or online help for instructions.

application or as the
Windows default
printer.

Your printer is not Select your printer in the Chooser as described in the Start Here card.
selected in the
Macintosh Chooser.

Paper settings in the Check the paper size, orientation, printable area, and layout settings to

printer software are make sure they’re correct for your paper size. See Selecting Paper Size
incorrect for your and Orientation Options and Selecting Print Layout Options for more
paper size. information.

The print head nozzles Clean the print head following the instructions in Cleaning the Print
are clogged. Head.
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Caution:

If you uninstall and
then reinstall the
printer software in
Windows 95, 98, or
NT 4.0, you must also
uninstall and then
reinstall Status
Monitor 2 so it can
recognize your
printer.

Troubleshooting

Uninstalling Printer Software

If you need to uninstall and reinstall your printer software, follow the
steps in the section for your operating system:

»  Windows 95, Windows 98, and Windows NT 4.0 Instructions
»  Windows 3.1 Instructions

» Macintosh Instructions

Windows 95, Windows 98, and Windows NT 4.0
Instructions

1 Double-click the My Computer icon, then double-click the
Control Panel icon.
Double-click Add/Remove Programs .

3 To uninstall the printer software, select EPSON Printer
Software in the program list.

4  Click the Add/Remove button. Follow the instructions on the
screen to uninstall your software.

5 Before you uninstall Status Monitor 2, turn off background

monitoring as described in Enabling Background Monitoring.
Then follow steps 1 through 4 again, selecting EPSON Status

Monitor 2 in the program list to uninstall it.

6 Restart your computer. To reinstall your software, see the Start
Here card.
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Troubleshooting

Windows 3.1 Instructions

1

Double-click the Main program group icon, then double-click
the Control Panel icon.

Double-click Printers .

Select EPSON Stylus COLOR 740 in the Installed Printers list
and click the Remove button.

To reinstall your software, see the Start Here card.

Macintosh Instructions

Insert the EPSON printer software CD-ROM in your drive.

Double-click the EPSON icon. After a moment, you see the
EPSON Stylus COLOR 740 Installer Main Menu.

Click Re-install Printer Driver |, then click the same button on
the next screen.

At the driver installation title screen, click Continue .

Click the arrow in the list at the top showing Easy Install, and
select Remove from the list.

Click the Remove button on the bottom of the screen.

Follow the instructions on the screen to uninstall the printer
software. Then restart your Macintosh.

To reinstall your software, see the Start Here card.
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Where To Get Help

EPSON provides technical assistance through electronic support
services and automated telephone services 24 hours a day. The
following tables list the contact information:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at
http://www.epson.com

EPSON Internet FTP Site If you have Internet FTP capability, use your Web browser
(or other software for FTP downloading) to log onto
ftp.epson.com with the user name anonymous and your
e-mail address as the password.

EPSON Download Service You can call the EPSON Download Service at

(800) 442-2007. Set your communications software to 8 data
bits, 1 stop bit, no parity. Modem speed can be up to

28.8 Kbps.

EPSON Forum on CompuServe® Members of CompuServe can type GO EPSON at the menu
prompt to reach the Epson America Forum. For a free
introductory CompuServe membership, call (800) 848-8199
and ask for representative #529.
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Automated telephone services

Service

Access

EPSON SoundAdyvicesv

For pre-recorded answers to commonly asked questions
about EPSON products 24 hours a day, seven days a week,
call (800) 442-2110.

EPSON FaxAdvice™

Access EPSON's technical information library by calling
(800) 442-2110. You must provide a return fax number to
use this service.

EPSON Referral Service

For the location of your nearest Authorized EPSON Reseller
or Customer Care Center, call (800) 442-2110.

To speak to a technical support representative, dial (310) 974-1188
(U.S.) or (905) 709-2567 (Canada), 6 AM to 8 PM, Pacific Time,
Monday through Friday and 7 AM to 4 PM, Saturday. Toll or long
distance charges may apply.

_ k Before you call, please have the following information ready:

Note:

If you need help
using another ’
manufacturer’s

software with an

EPSON product, see ’
the documentation
for that software for
technical support
information.

You

Troubleshooting

Product name

Product serial number (located on the back of the printer)
Computer configuration

Description of the problem

can purchase ink cartridges, paper, manuals, and accessories

from EPSON Accessories at (800) 873-7766 (U.S. sales only). In
Canada, please call (800) 873-7766 for dealer referral.
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Printing
Printing method

Nozzle configuration

Resolution

Input buffer
Print direction
Control code
Character tables
Character sets

Bitmap fonts

Specifications

On-demand ink jet

144 black nozzles
144 color nozzles (48 cyan, 48 magenta, 48 yellow)

Maximum 1440 x 720 dpi

64KB

Bidirectional with logic seeking

ESC/P 2™ and raster graphics code and EPSON Remote
1 italic and 10 graphics character tables

14 international character sets and 1 legal character set

» EPSON Roman (proportional)

» EPSON Sans Serif (proportional)
» EPSON Courier

» EPSON Prestige

» EPSON Script

All bitmap fonts are available in 10, 12, and 15 cpi. You can select other font/pitch
combinations using ESC/P 2 commands.
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Scalable fonts

Paper

» EPSON Roman

» EPSON Sans Serif

» EPSON Roman T

» EPSON Sans Serif H

All scalable fonts are available in sizes from 8 to 32 points, in 2 point increments,
and four styles: normal, bold, italic, and bold italic.

The printer always uses the fonts you select with your software application. You
need to use the printer’s internal fonts only if your application doesn’t allow you to

select fonts.

Paper type

Size

Paper types

Thickness

W

eight

Single sheets

Letter (8.5 x 11 inches)

A4 (210 x 297 mm)

A5 (148 x 210 mm)

B5 (182 x 257 mm)

Legal (8.5 x 14 inches)
Half letter (5.5 x 8.5 inches)
Executive (7.5 x 10 inches)

Plain paper and
special ink jet
papers
distributed by
EPSON

0.003t00.004 inch
(0.08 t0 0.11 mm)

17to 24 1b
(64t090 g/mz)

Transparencies
and glossy
media

Letter (8.5 x 11 inches)
A4 (210 x 297 mm)
A6 (105 x 148 mm, glossy film

only)

Transparencies,
glossy paper,
and glossy film
distributed by
EPSON

Specifications
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Photo Paper

4 x 6 inches (102 x 152 mm)
Letter (8.5 x 11 inches)

A4 (210 x 297 mm)

Panoramic (8.27 x 23.4 inches)

Photo Paper
distributed by
EPSON

Photo stickers

A6 (105 x 148 mm)
with 16 frames

Photo stickers
distributed by

iron-on cool peel
transfer paper

peel transfer paper only)

iron-on cool peel
transfer paper
distributed by
EPSON

EPSON
Self adhesive A4 (210 x 297 mm) Self adhesive — —
sheets and Letter (8.5 x 11 inches; cool sheets and

Envelopes

#10 9.5 x 4.1 inches
(240 x 104 mm)
DL 8.7 x 4.3 inches
(220 x 110 mm)
C6 4.4 x6.4inches
(114 x 162 mm)
Note card envelope
5.2 x 8.7 inches
(132 x 220 mm)

Plain, bond, or
air mail paper

0.006 to 0.02 inch
(0.16 to 0.52 mm)

12t0 20 Ib
(45 to 75 g/m?)

Cards

A6 (105 x 148 mm)
8 x 10 inches (203 x 254 mm,;
ink jet cards only)

Ink jet cards and
note cards
distributed by
EPSON

Specifications
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Note:

Print only under these conditions:
Temperature: 59to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Store glossy film and self adhesive sheets under these conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, EPSON cannot guarantee the use af any particular brand or type of paper. Always test
samples of paper stock before purchasing large quantities or printing

large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you

encounter problems, switch to a higher grade of paper. Do not load curled or folded paper,
envelopes, or transparencies.
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Printable area

A

B-L 7

B-R 3
gl e
B-L— NB-R
i i}—c
XH C Envelopes

Single sheets and cards

Note:

Always load paper
into the sheet feeder
short edge first
except envelopes.
Load envelopes long
edge first.

Specifications

A~

EPSON Panoramic
Photo Paper

B-R

BR

The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of EPSON Photo Quality Glossy Film, the
minimum top margin is 1.2 inches (30 mm).

The minimum left margin is 0.12 inch (3.0 mm).

The minimum right margin is:

0.35inch (9.0 mm) for Letter and Legal
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes

0.12 inch (3.0 mm) for all other paper sizes.

The minimum bottom margin is 0.55 inch (14.0 mm) using the Standard
printable area setting. This can be decreased to 0.12 inch (3.0 mm)
using the Maximum printable area setting. However, the print quality in
the expanded printable area may be reduced.www
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Ink Cartridges

Specification Black ink cartridge (S020189) Color ink cartridge (S020191)
Color(s) Black Cyan, magenta, and yellow
Print 900 pages text (ISO/IEC 10561 letter pattern) | 300 pages (15% coverage)
capacity* 300 pages graphic (5% coverage)

Cartridge life | 2 years from production date and up to within 6 months after opening package at
77 °C (25 °F)

Storage -4 10 104 °F (20 to 40 °C)
temperature | 1 month at 104 °F (40 °C)
Transit —22 t0 140 °C (-30 to 60 °F)

temperature | 1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 3.2 °F (-16 °C) —0.4 °F (-18 °C)

temperature**

Dimensions 1.09 (W) x 2.1 (D) x 1.5 (H) inches 1.7 (W) x 2.1(D) x 1.5 (H) inches
27.8 (W) x52.7 (D) x 38.5 (H) mm 42.9 (W) x 52.7 (D) x 38.5 (H) mm

* The print capacity may vary depending on how often you clean the print head.
** The ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
~ To ensure good results, use genuine EPSON cartridges and do not refill them. Other products may
- cause damage to your printer not covered by EPSON'’s warranty.

Do not use an ink cartridge after the expiration date on the package.
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Mechanical

Paper feed method Friction with auto sheet feeder, rear entry

Sheet feeder Maximum 100 sheets of 17 Ib (64 g/m?) paper
capacity
Dimensions

Storage Width: 16.9 inches (429 mm)

Depth: 10.3 inches (261 mm)
Height: 6.6 inches (167 mm)

Printing Width: 16.8 inches (429 mm)
Depth: 24.1 inches (613 mm)
Height: 12.2 inches (309 mm)

Weight 11.5 Ib (5.2 kg) without the ink cartridges
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Electrical

Specification 120V model 240V model*

Input voltage range 99V to 132V 198V to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5t0 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 18 W (ISO 10561 Letter Pattern)
Approx. 5 W in standby mode

* Also designed for IT power systems with Phase to Phase voltage
220-240V

Environmental

Temperature Operation 50 to 95 °F (10 to 35 °C)
Storage* —4 to 104 °F (=20 to 40 °C)
1 month at 104 °F (40 °C)

Transit* —4to 140 °F (-20 to 60 °C)
120 hours at 140 °F (60 °C)
Humidity Operation 20 to 80% RH

Storage* 5 to 85% RH (without condensation)

* Stored in shipping container
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Safety Approvals

Safety standards UL 1950, CSA 22.2 No. 950
EMC FCC part 15 subpart B class B

DOS Support

If driver support for the EPSON Stylus COLOR 740 is not available
from your software manufacturer, you can use one of the other
EPSON ESC/P 2 printer drivers. These drivers don't provide all the
EPSON Stylus COLOR 740 features, such as 720 or 1440 dpi
printing. Choose the first printer available from the following two
lists:

Black printing only » LQ-870/1170
» LQ-570(+)/1070(+)
» SQ-870/1070
» LQ-850
» LQ-500

Color and black » EPSON Stylus PRO
printing » EPSON Stylus COLOR 500
» EPSON Stylus COLOR II
» LQ-860
» LQ-2550
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Control Panel Settings

You can change the following default settings from the printer’s
control panel:

Setting Options

Font Courier, Roman, Sans Serif, Prestige, Script,
Roman T, Sans Serif H, Draft

Character table Italic U.S.A., ltalic France, Italic Germany, Italic

U.K., Italic Denmark 1, Italic Sweden, Italic Italy,
Italic Spain 1, PC 437 (U.S./Standard Europe),
PC850 (Multilingual), PC860 (Portuguese), PC861
(Icelandic), PC863 (Canadian-French), PC865
(Nordic), Abicomp, BRASCII, Roman 8, ISO Latin 1

Changing control Follow these steps to change the settings listed above:

panel settings ) .
1 Make sure the printer is turned off and has paper loaded (at

least 8.27 inches [210 mm] wide).

2 Hold down the 4 cleaning button and press the O power
button. The printer prints a summary of instructions for
changing settings and choosing a language for the instructions.

3 Pressthe ™ load/eject button to print a list of current settings
(indicated with arrows) and additional instructions.

4  After you make the changes you want, turn the printer off to
save the settings. The settings remain in effect until you change
them again.
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Character Tables

All character tables except Italic are the same as the PC437 table
for hex codes 00 through 7F. Additional characters are available for
hex codes 80 through FF. You can select the following character
tables through the control panel or software commands:

» PC437 (U.S./Standard Europe)
» PC850 (Multilingual)

» PC860 (Portuguese)

» PC861 (Icelandic)

» PC863 (Canadian-French)

» PC865 (Nordic)

» Abicomp

» BRASCII

» Roman 8

» ISO Latin 1

» Italic (no characters available for hex code 15)

International You can select a number of international character sets with the

character sets control panel or the ESC R command. Other sets can only be
selected with the ESC R command. You can select additional
characters with the ESC (~ command.
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Interfaces

Parallel interface Forward channel

Specification Description

Data format 8-bit parallel, IEEE-1284 compatibility mode

Synchronization STROBE pulse
Handshake timing | BUSY and ACKNLG signals
Signal level TTL compatible

Connector 57-30360 Amphenol connector or equivalent

Reverse channel

Specification Description
Transmission mode IEEE-1284 Nibble mode

Adaptable connector |57-30360 Amphenol connector or equivalent

Synchronization Refer to the IEEE-1284 specification
Handshaking Refer to the IEEE-1284 specification
Signal level IEEE-1284 Level 1 device

Data transmission Refer to the IEEE-1284 specification
timing
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Serial interface

USB interface

Specifications

Specification Description
Standard Based on RS-423
Synchronization Synchronous

Bit rate

Approximately 1.8M bps

Handshaking

X-ON/X-OFF and DTR protocol

Word format

Data bit; 8 bits
Parity bit: None
Start bit: 1 bit

Stop bit: 1 bit
Connector 8-pin mini-DIN
Recommended Apple System Peripheral-8 cable (preferably
cable Belkin brand)

Specification Description

Standard Based on Universal Serial Bus Specifications
Revision 1.0, Universal Serial Bus Device Class
Definition for Printing Devices Version 1.0

Bit rate 12 Mbps (full speed device)

Data encoding NRZI

Adaptable USB Series B

connector

Recommended 6.5 feet (2 meters)

cable length
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Accessories, 83, 123, 166
Advanced mode, selecting, 33 to 34,
36 to 38
Advanced settings
color, 40 to 48
layout, 59 to 75
orientation, 48 to 52, 55 to 56
paper size, 48 to 58
print quality, 36 to 40
project types, 33 to 36
saving custom, 78 to 80
special effects, 36 to 40
Aligning print heads, 133, 143
Automatic mode, 22, 29

Background printing
Macintosh, 29 to 31, 114 to 118
Windows, 101 to 114

Banding, 142 to 143

Basic printing, 19 to 31

Bitmap files, 65 to 67

Blank pages, 162

Blurry printouts, 145 to 146

Brightness setting, 44

C

Index

Cards, see Photo Quality Ink Jet and
Note Cards

Character sets, international, 167,
176to 177

Character tables, 167, 176 to 177

Characters, garbled, 159 to 160

Checking printer, 139 to 140

Cleaning print heads, 129 to 131

Cleaning printer, 134

Cleaning sheets, 84

Collate setting, 51, 58

Color Adjustment modes, 43 to 44

Color problems, 143 to 144

Color settings, customizing, 40 to 48

ColorSync, using, 35, 46 to 48

Configuration options, Macintosh,
120to 121

Contrast setting, 44

Control code, 167

Control panel default settings, 176

Control panel, using, 130 to 131,
13810 139, 176

Cool Peel Iron-On Transfer Paper,
see Iron-On Transfer Papers
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Index

Custom settings
color, 40 to 48
deleting, 80
layout, 59 to 75
orientation, 48 to 52, 55 to 56
paper size, 48 to 58
print quality, 36 to 40
project types, 33 to 36
redefining, 79 to 80
saving, 78 to 80
special effects, 36 to 40
Cyan setting, 44

Default control panel settings, 176

Default printer options, setting,
23to 24

Despooler, 26, 111

Diagnosing problems, 137 to 141

Diffusion, error, 39

Digital Camera setting, 35, 41 to 42

Dithering, 39

DMA transfers, 99, 154

DOS support, 19, 175

Economy setting, 35, 38
Electrical specifications, 174
Energy Star, 15
Envelopes
loading, 87 to 88
specifications, 169 to 171

Environmental specifications, 174
EPSON
Accessories, 83, 123, 166
help, 165 to 166
media, 81 to 94
printer port, 98 to 99, 148, 159
EPSON Spool Manager, see Spool
Manager
Error Diffusion setting, 39
Error notification, 106 to 109,
120to 121

ESC/P 2 control code, 167

Faint printouts, 145

Film, see Photo Quality glossy media
Finest Detail setting, 40

Fit to Page setting, 63, 69 to 71

Flip Horizontal setting, 40, 94, 160
Fonts, 167 to 168, 176

Forms, loading, 85

Garbled characters, 159 to 160

Glossy media, see Photo Quality
glossy media

Graph setting, 35, 42

Halftoning setting, 39, 143
Head Cleaning utility, 129 to 130
Help, 165 to 166
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High Speed copies, 98, 120 to 121
High Speed setting, 39, 141, 143

Horizontal banding, 142

120 to
141

ICM (Image Color Matching) setting,
35,4510 46

Ink
cartridge specifications, 172
monitoring level, 109, 118 to 119
replacing cartridges, 123 to 128
replacing outdated cartridge, 127

smears, 88
specifications, 172
Ink Jet Cards, see Photo Quality Ink
Jet and Note Cards
Ink Jet Paper
choosing, 21, 28, 82 to 83
loading, 84
specifications, 168 to 171
Ink Jet Transparencies, see
Transparencies
Interface specifications, 178 to 179
International character sets, 167,
176to 177
Introduction, 9 to 18
Iron-On Transfer Papers
choosing, 82 to 83
loading, 84, 94
specifications, 169 to 171

J Jammed paper, 138, 158

Job Status window, 109 to 110

L Landscape setting, 51, 56
Layout
icon, 29, 58, 70
options, setting, 59 to 75
problems, 160 to 161
tab, 22, 62
Letterhead, loading, 85
Lights, using, 138 to 139

M Macintosh
background printing, 29 to 31
ColorSync, 46 to 48
configuration options, 120 to 121
increasing memory allocation,
115
managing print jobs, 115 to 118,
120to 121
Monitor3, 114 to 118
previewing, 30, 76 to 77
printing from, 27 to 31
problems printing, 151 to 156
Status Monitor, 118 to 119
system requirements, 11 to 12
uninstalling software, 164
Magenta setting, 44
Main tab, 21
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Index

Maintaining printer, 122 to 134
Manuals, how to use, 14 to 15
Margin
problems, 161
with multiple sheets, 85
Mechanical specifications, 173
Media Type setting, 21 to 22,
2810 29, 34, 38, 8210 83, 141
Memory allocation, increasing on
Macintosh, 115
MicroWeave setting, 39, 142
Monitor3, 114 to 118
Monitoring
ink level, 109, 118 to 119
preferences, Windows,
102 to 104
print jobs, see Background
monitoring
More Settings dialog box, 36 to 46
Moving printer, 135
Multiple print layouts, 64 to 65,
721073

Note Cards, see Photo Quality Ink
Jet and Note Cards

Nozzle Check, 132

Orientation options, 48 to 52,
55 to 56
Outdated ink cartridge, 127

Packing printer, 135

Page frames, 64 to 65, 72 to 73

Page Order options, 64, 72

Page Setup dialog box, 27, 55

Panoramic Photo Paper, see Photo
Paper

Paper
choosing, 82 to 83
handling problems, 156 to 158
loading, 84 to 94
specifications, 168 to 171

Paper jams, 138, 158

Paper Size options, 48 to 58

Paper support, 85, 89

Paper tab, 22, 49

Paper thickness lever, 88, 91, 92,
143, 145

Parallel interface specifications, 178

Photo Paper
choosing, 21, 28, 82 to 83
loading, 84, 89 to 91
specifications, 169 to 171

Photo Quality glossy media
choosing, 21, 28, 82 to 83
loading, 84 to 86
specifications, 168 to 171

Photo Quality Ink Jet and Note Cards
choosing, 82 to 83
loading, 84, 92
specifications, 169 to 171
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Photo Quality Ink Jet Paper
choosing, 21, 28, 82 to 83
loading, 84
specifications, 168 to 171

Photo Quality Self Adhesive Sheets
choosing, 82 to 83
loading, 84, 93
specifications, 169 to 171

Photo Stickers
choosing, 82 to 83
loading, 84, 93
specifications, 169

PhotoEnhance setting, 34, 40 to 42

PICT files, 73 to 74

Plain paper, 21, 28, 168to 171

Portrait setting, 51, 56

Preprinted forms, loading, 85

Previewing, Macintosh, 30, 76 to 77

Print dialog box, 20

Print Head Alignment utility, 133, 143

Print heads, cleaning, see Cleaning
print heads

Print jobs
managing in Windows, 96 to 114
managing on Macintosh,

114 to 118, 120 to 121

Print layouts, multiple, 64 to 65,
72t0 73

Print Order options, 58 to 59

Print quality
customizing, 36 to 40
problems, 141 to 146

Print time, setting, 30 to 31,
117to 118
Printable area
setting, 51, 56, 86, 142
specifications, 171
Printer check, 139 to 140
Printer ID, checking, 140 to 141
Printer parts, 13
Printer port, EPSON, 98 to 99, 148,
159
Printer software
problems, 151 to 156
settings, see Settings, printer
software
uninstalling, 163 to 164
Problems
diagnosing, 137 to 141
paper handling, 156 to 158
print quality, 141 to 146
printer software, 151 to 156
printing, 147 to 150
solving, 136 to 164
unexpected printout results,
159 to 162
uninstalling software, 163 to 164
Progress Meter
dialog box, 25
Speed & Progress options,
97 to 99
Project types, custom, 33 to 36
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Quality/Speed slider, 22, 29

ReadMe files, 137

Reduce/Enlarge setting, 50, 60 to 63
Rendering Intent setting, 48
Replacing ink cartridges, 123 to 128
Resolution, see Print quality
Reverse Order setting, 51, 59
Rotate by 180° setting, 51, 56

Safety approvals, 175

Safety instructions, 16 to 18

Saturation setting, 44

Self Adhesive Sheets, see Photo
Quality Self Adhesive Sheets

Serial interface specifications, 179

Service, 165 to 166

Settings, printer software
advanced, see Advanced settings
basic, 20 to 23, 27 to 31
default, 23 to 24
reusing on Macintosh, 27

Sharpness setting, 42

Smears, 88, 145 to 146

Special effects, 36 to 40

Specifications
character tables, 167, 176 to 177
control panel settings, 176
DOS support, 175
electrical, 174
environmental, 174
ink cartridges, 172
interface, 178 to 179
mechanical, 173
paper, 168 to 171
printing, 167 to 168
safety approvals, 175
Speed & Progress options, 25,
971t0 99
Spool directory, changing default,
113to0 114
Spool folders, 98, 120 to 121
Spool Manager
problems, 148, 152, 159
using with Windows 3.1,
111to 114
using with Windows 95 and 98,
100to 101
sSRGB (Standard Red Green Blue)
setting, 35, 45 to 46
Stalled print jobs, deleting, 101, 110,
113
Status Alert dialog box, 103 to 104
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Status Monitor
Macintosh, 118 to 119
problems, 137, 153
uninstalling, 163
Windows, 25, 101 to 110
Support, 165 to 166

System requirements, 10 to 12

Technical specifications, 167 to 179
Text/Graph setting, 35, 42
Tone setting, 42
Transparencies
choosing, 21, 28, 82 to 83
loading, 84 to 86
specifications, 168 to 171
Transporting printer, 135
Troubleshooting, 136 to 166

USB interface specifications, 11, 179
User Defined paper size, 52 to 54,
57 to 58
Utility
dialog box, 97, 118
icon, 129, 131, 133

tab, 129, 131, 133

Vertical banding, 143

W Watermarks, 65 to 68, 73to 75

Windows
default options, setting, 23 to 24
managing print jobs, 96 to 114
printing from, 19 to 24
problems printing, 151 to 156
system requirements, 10 to 11
uninstalling software, 163 to 164
Windows 3.1
default options, setting, 24
managing print jobs, 111 to 114
printer status, checking, 26
uninstalling software, 164
Windows 95 and 98
default options, setting, 23
managing print jobs, 96 to 110
printer status, checking, 25
Status Monitor 2, 25
uninstalling software, 163
Windows NT
default options, setting, 23
managing print jobs, 25, 96 to 99,
101 to 110
Status Monitor 2, 25, 101 to 110
uninstalling software, 163

Year 2000, 16
Yellow setting, 44
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